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This guide contains everything you need to know to distribute an app through the App Store or Mac App
Store.

 ● Get step-by-step guidance for enrolling in an Apple Developer Program and building, testing, and submitting
your app.

 ● Configure technologies that are available only to apps submitted to the App Store or Mac App Store.

 ● Test your app on multiple devices and system versions, or offer testers a preview of your next release.

 ● Upload metadata about your app so the store can present it to customers.

 ● Verify that you’ve prepared your app correctly, and submit it to the store.

 ● Learn how to release and maintain your app after submission.

Enroll in Program

Release App

Submit App

Create iTunes Record

Develop & Test
Distribution Tasks

You perform these tasks using Xcode features and several web tools available only to members of an Apple
Developer Program. Before you use certain key technologies and services, such as iCloud and Game Center,
you must join an Apple Developer Program. You should join a program even if you distribute a Mac application
outside of the Mac App Store so that customers know your application comes from a known source.
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Note:  If you just want to use Xcode to run an app on a device or write code that uses a service, read
AppDistribution Quick Start first and then return to this document for additional tasks you’ll perform
throughout the lifetime of your app.

At a Glance
This guide explains how to develop, test, submit, and release your iOS and Mac apps. By understanding your
tools and the distribution process, you’ll be able to get your new app and updates to your customers faster.

Enroll in an Apple Developer Program to Distribute Your App
Joining an Apple Developer Program is the first step to submit your apps on the App Store and Mac App Store,
or to sign apps that you distribute outside the Mac App Store with a Developer ID. As a member, you have
access to the resources you need to configure technologies and to submit new apps and updates.

Related Chapter:  “Managing Accounts” (page 17)

Add Store Capabilities to Your App
Apple provides advanced, integrated services for certain types of apps, such as games and Newsstand apps,
and for additional sources of revenue, such as In-App Purchase and iAd Network. These technologies and
services require additional configuration—both during development and later, when you submit your app to
the App Store or Mac App Store. Good examples are Game Center and iCloud. In this guide, you’ll learn how
to add these capabilities to your app.

Related Chapter:  “Adding Capabilities” (page 54)

Prepare Your App for Distribution
Before you distribute your app for testing or submit it to the store for approval, you should complete the
configuration of your Xcode project. Your final Xcode project should contain required app icons and launch
images, contain additional entitlements for technologies you add, and specify which devices and operating
systems your app supports.

About App Distribution
At a Glance
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Related Chapter:  “Configuring Your Xcode Project for Distribution” (page 22)

Test iOS Apps Across Numerous Devices
If you have an iOS app, make sure you test it not only in iOS Simulator but on all the devices and releases that
your app supports. Testing on more than one kind of device ensures that your app operates exactly as you
thought it would, no matter which device it’s running on. You can register up to 100 devices per membership
year for development and testing. After testing an app yourself, distribute it to testers. You first create a special
profile—an ad hoc provisioning profile—to ensure that test versions of your app aren’t copied and distributed
without your knowledge, and then collect device IDs from testers you’ve selected.

Related Chapters:  “Beta Testing Your iOS App” (page 91), “Analyzing Crash Reports” (page 107)

Submit and Release Your App
Submitting your app to the store is a multistep process. First, you sign in to iTunes Connect, and enter necessary
information to change the state of your app record to “Waiting for Upload” or later. If you’re selling your app
on the store, you also enter the information for your reimbursement in iTunes Connect. Then you create an
archive and sign it with your distribution certificate in Xcode. Last, you submit your app using Xcode or
Application Loader. When your app is approved, you use iTunes Connect to release it by setting the date when
the app will be available to customers. If you’re distributing your Mac app outside the store, you follow a slightly
different process.

Related Chapters:  “Submitting Your App” (page 109), “Releasing and Updating Your App” (page
126), “Managing Your App in iTunes Connect” (page 127), “Distributing Applications Outside the Mac
App Store” (page 217)

Maintain Your Certificates, Identifiers, and Profiles
Apple implements an underlying security model to protect both user data and your app from being modified
and distributed without your knowledge. Throughout the development process, you create assets and enter
information that Apple uses to identify you, your devices, and your apps. Xcode automatically creates many
certificates, identifiers, and profiles for you as you need them. Xcode maintains the App IDs and provisioning
profiles it creates for you, but not the other assets. During your Developer Program membership, you maintain
various other certificates, identifiers, and profiles yourself.

About App Distribution
At a Glance
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Related Chapters:  “Maintaining Your Signing Identities and Certificates” (page 145), “Maintaining
Identifiers, Devices, and Profiles” (page 181)

How to Use This Document
How you use this document depends on the type of developer program you join (iOS Developer Program or
Mac Developer Program) and your role (team agent, admin, or member). For Mac apps, how you use this
document also depends on whether you choose to submit your app to the Mac App Store or outside of the
Mac App Store.

First choose a type of account (individual or company) and a developer program. If needed, create an Apple
ID and join a developer program, as described in “Managing Accounts” (page 17). If you enroll in a developer
program as an individual, you’re the team agent for a one-person team. If you enroll in a developer program
as a company, you’re the team agent and can invite other people to join your team, as described in “Inviting
Team Members” (page 139). You specify whether a person is a team admin, who can perform most of the same
tasks as a team agent, or team member who can’t create assets in Member Center. To learn more about team
roles, read “About Apple Developer Program Team Roles and Privileges” (page 136).

Then refer to the tables in this section for the tasks you perform depending on your role and developer program
membership. (Refer to the glossary for the definitions of terms used in this guide.)

If you’re a team agent or admin and want to submit your app to the App Store or Mac App Store:

ReadTo learn how to

“Adding Your Apple ID Account in Xcode” (page
18)

Add your Apple ID to Xcode

“Configuring Identity and Team Settings” (page
25)

“Configuring Your Xcode Project for
Distribution” (page 22)

Set your bundle ID and assign your
project to a team

“Adding Capabilities” (page 54)Configure store-specific technologies

“Launching Your App on Devices” (page 84)Launch your app on devices

“Configuring Your Xcode Project for
Distribution” (page 22)

Perform final configuration steps before
distributing your app

“Beta Testing Your iOS App” (page 91)Test your iOS app on different devices

About App Distribution
How to Use This Document
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ReadTo learn how to

“Analyzing Crash Reports” (page 107)Fix problems during testing

“Submitting Your App” (page 109)Upload your app to iTunes Connect for
approval

“Releasing and Updating Your App” (page 126)

“Managing Your App in iTunes Connect” (page
127)

Release your app by setting the
availability date

“Maintaining Your Signing Identities and
Certificates” (page 145)

“Maintaining Identifiers, Devices, and
Profiles” (page 181)

Maintain your Apple Developer Program
assets

“Troubleshooting” (page 230)Fix issues with your code signing assets

If you’re a team agent or admin for a company:

ReadTo learn how to

“Managing Your Team” (page 136)Add team members and assign roles for company
accounts

If you’re a team member for a company that wants to submit your app to the App Store or Mac App Store:

ReadTo learn how to

“Adding Your Apple ID Account in
Xcode” (page 18)

Add your Apple ID to Xcode

“Configuring Identity and Team Settings” (page
25)

“Configuring Your Xcode Project for
Distribution” (page 22)

Set your bundle ID and assign your project
to a team

“Approving Development Certificates” (page
141)

Request your development certificate and
ask your team agent or admin to approve
it

“Registering Team Member Devices” (page 143)Ask your team agent or admin to register
your device

About App Distribution
How to Use This Document
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ReadTo learn how to

“Launching Your App on Devices” (page 84)Launch your app on devices

“Troubleshooting” (page 230)Fix issues with your code signing assets

If you’re a team agent and want to distribute your Mac application outside of the Mac App Store:

ReadTo learn how to

“Configuring Your Xcode Project for
Distribution” (page 22)

Perform final configuration steps before
distributing your app

“Distributing Applications Outside the Mac App
Store” (page 217)

Create a Developer ID-signed application

“Requesting Additional Developer ID
Certificates” (page 155)

Request additional Developer ID certificates

For Mac apps, if you select None as the distribution method, as described in “Choosing a Signing Identity for
Mac Apps” (page 28), you don’t need to read this guide.

See Also
You should already be familiar with the software and tools you use to write code before reading this guide. If
not, there are a number of platform-specific tutorials you should read first. Next, read the technology overview
documents followed by the appropriate human interface guidelines for your platform, and most important,
the guidelines for submitting your app to the store.

MaciOS

Start Developing Mac Apps Today

App Distribution Quick Start

Start Developing iOS Apps Today

App Distribution Quick Start

To get started . . .

Mac Technology Overview

Mac App Programming Guide

iOS Technology Overview

iOS App Programming Guide

To learn more about
technologies . . .

OS X Human Interface Guidelines

AppStoreReviewGuidelinesforMac
Apps

iOS Human Interface Guidelines

App Store Review Guidelines for iOS
Apps

To learn about the user
interface guidelines . .
.

About App Distribution
See Also
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MaciOS

Xcode Overview

iTunes Connect Developer Guide

Using Application Loader

Xcode Overview

iTunes Connect Developer Guide

iOS Simulator User Guide

Using Application Loader

To learn more about
tools . . .

About App Distribution
See Also
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The Accounts preferences pane is the central location for managing all of the accounts your projects will use
including your Apple ID used to manage Apple Developer Program assets. By adding an Apple ID account,
joining an Apple Developer Program, and assigning your project to a team, you provide Xcode with the
credentials to manage your certificates, identifiers, and profiles. You’ll learn how to manage your accounts in
this chapter.

About Apple Developer Program Memberships
Apple Developer Programs offer a complete set of technical resources, support, and access to prerelease
software, providing everything you need to create innovative apps for iOS and Mac, extensions for Safari, and
accessories for iOS devices. After you enroll in the iOS Developer Program or Mac Developer Program, you
have full access to Member Center and iTunes Connect.
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You Enroll as an Individual or a Company
During the enrollment process, you choose whether to enroll as an individual or a company. If you enroll as
an individual, you’re considered a one-person team, one who can perform all the tasks described in this guide
except manage multiple team members.

During enrollment, you’re asked for basic personal information, including your legal name and address. If you
enroll as a company, you provide a few more things, such as your legal entity name and D-U-N-S Number, as
part of the verification process. When your information is verified, you review license agreements, purchase
your program on the Apple Online Store, and receive details on how to activate your membership.

If you enroll as a company, you may add other persons to your team and grant them privileges to manage
your account. All team members must be Registered Apple Developers. Team members have different privileges,
so depending on your role, you may not be able to perform all the tasks in this book.

To learn about the different roles and privileges, read “About Apple Developer Program Team Roles and
Privileges” (page 136).

You Can Join Multiple Teams
You can use an Apple ID to join multiple teams but with some restrictions.

Registered Apple Developers receive an Apple ID that identifies a person, not a membership in an Apple
Developer Program. The Apple ID must have a unique email address associated with it that’s verified by Apple.
You use your Apple ID to sign in to Member Center and iTunes Connect.

A single Apple ID can be associated with multiple Member Center teams. Using the same Apple ID, you can
enroll as an individual and join other teams. However, you can only be associated with a single iTunes Connect
team. Consequently, developers should create another Apple ID for different individual or company accounts
that they want to manage separately in iTunes Connect.

Emails from Apple Contain Further Instructions and Welcome You
When you enroll in an Apple Developer Program or are invited to join a team, you receive a series of emails.
For example, if you register as an Apple developer, Apple sends you an email requesting that you confirm your
email address. Following the instructions in these emails promptly will streamline the enrollment process.

Adding Your Apple ID Account in Xcode
Start by adding your account using the Accounts preferences pane in Xcode. If you haven’t joined an Apple
Developer Program, you can join directly from Xcode. You can also add multiple Apple ID accounts.

Managing Accounts
Adding Your Apple ID Account in Xcode
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To add an Apple ID account

1. Choose Xcode > Preferences.

2. Click Accounts at the top of the window.

3. Click the Add button (+) in the lower-left corner.

4. Choose Add Apple ID from the pop-up menu.

5. If you have an Apple ID that belongs to an Apple Developer Program, enter your Apple ID and password,
and click Add.

Managing Accounts
Adding Your Apple ID Account in Xcode
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6. Otherwise, click “Join a Program” in the lower-left corner of the dialog.

Your default browser displays the Apple Developer Programs enrollment webpage. In your browser,
click the developer program you want to join and follow the instructions.

To remove an Apple ID account

1. Choose Xcode > Preferences.

2. Click Accounts at the top of the window.

3. Select the Apple ID account you want to delete in the left column.

4. Click the Delete button (–) in the lower-left corner.

Adding a Developer Program to Your Team
Your team may join multiple Apple Developer Programs. For example, if you initially join the iOS Developer
Program, you can add the Mac Developer Program to your team account.

Managing Accounts
Adding a Developer Program to Your Team
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To add a developer program to your team

1. Choose Xcode > Preferences.

2. Click Accounts at the top of the window.

3. Select your Apple ID in the left column.

4. Click Join in the row of the team and column of the program you want to join.

For example, click Join under Mac to add the Mac Developer Program. Your default browser displays
the developer program enrollment webpage.

5. In your browser, click “Enroll now” and follow the instructions.

Recap
In this chapter, you learned how to add your Apple ID account and join the iOS Developer Program or Mac
Developer Program. Later, you’ll assign your Xcode project to one of your teams. Xcode uses this information
to create your certificates, identifiers, and profiles for you.

Managing Accounts
Recap
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You can edit your project settings anytime but some settings are necessary during development and others
are recommended when you distribute your app for beta testing and required when you submit your app to
the store.

During development, your app must be provisioned and code signed to use certain Apple services and run on
an iOS device (an iPad, iPhone, or iPod touch). If you assign a bundle ID and team to your project, Xcode can
create the necessary certificates, identifiers, and profiles for you in Member Center. You can enter this information
now using the project editor or as needed when you add services and launch your app.

Before you distribute your app for testing or to the store, provide all the required information about your app.
For example, set app icons and launch images to pass iTunes Connect validation tests.

Before you submit your app to the store, verify your build settings and set the copyright key for Mac apps.

Setting Properties When Creating Your Xcode Project
An assistant guides you through the process of creating an Xcode project. First, you select a template for your
project. Starting with the right template helps speed the development process. The assistant also prompts
you to enter information about your app that’s used to determine your app’s capabilities and distribute it to
customers. If you don’t have this information when you create the project, you can set these properties later.
Some of the data in the Xcode project is similar to the data you enter in iTunes Connect, but only the bundle
ID needs to match the bundle ID you enter in iTunes Connect before you can submit your app to the store.
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Note:  If you don’t have an Xcode project, read the tutorial in Start Developing iOS Apps Today or
Start Developing Mac Apps Today to learn how to create one. You can’t perform the tasks in this
book without first creating an Xcode project that builds and runs an app.

For iOS apps, a dialog similar to this appears when you create an Xcode project from a template:

The product name is the name of your app as it will appear to customers and should be similar to the app
name you enter later in iTunes Connect. Most importantly, a customer should instantly associate the app name
and icon in the App Store with the product name and app icon that installs on their devices. The product name
is also the name that will appear in Springboard when the app is installed. The product name can’t be longer
than 255 bytes, and can be no fewer than 2 characters. (Read “Best Practices” in iTunes Connect Developer
Guide for guidelines on choosing an app name.)

The organization name is an attribute of the Xcode project and is used in boilerplate text throughout your
project folder. For example, the organization name is used in the source and header file copyright strings. The
organization name in your Xcode project isn’t the same as the company name that you enter later in iTunes
Connect.

The product name and company identifier you enter are concatenated to create the default bundle ID using
reverse domain name service (reverse DNS) notation. The bundle ID needs to be unique to your app, so it’s
important to set the company identifier to a unique string as well.

Configuring Your Xcode Project for Distribution
Setting Properties When Creating Your Xcode Project
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For iOS apps, you can choose the types of devices you support from the Devices pop-up menu. For Mac apps,
you can choose the Mac App Store categories from a pop-up menu.

The other values used by the Xcode template are sufficient for building and running your app locally, but later
you’ll need to finalize properties, such as the bundle ID. Also, the assistant doesn’t set all required properties
for the store. You complete the basic store configuration before you submit. Ideally, you’ll complete this
configuration before you distribute your app for testing too.

After your app is released, you can’t change some of this metadata, so it’s important to choose your settings
carefully. To learn which app states cause some properties to be locked in iTunes Connect, refer to “iTunes
Connect App Properties” in iTunes Connect Developer Guide .

Before You Begin Configuring Your Project
All of the options discussed in this chapter are located in the General pane in the project editor for your target.
To open the project navigator, choose View > Navigators > Show Project Navigator. Choose the target from
the Project/Targets pop-up menu or in the Targets section of the second sidebar if it appears. Click General to
view settings discussed in this chapter.

The screenshot below shows the General pane for an iOS app.

Configuring Your Xcode Project for Distribution
Before You Begin Configuring Your Project
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Configuring Identity and Team Settings
For Xcode to create the team provisioning profile, the app’s bundle ID needs to be unique and the project
assigned to a team. Later, you provide other information that identifies this version of your app. The identity
settings appear in the Identity section of the target’s General pane. For iOS apps, the Identity section appears
as shown here:

About Bundle IDs
A bundle ID precisely identifies a single app. A bundle ID is used during the development process to provision
devices and by the operating system when the app is distributed to customers. For example, Game Center
and In-App Purchase use a bundle ID to identify your app when using these services. The preferences system
uses this string to identify the app for which a given preference applies. Similarly, Launch Services uses the
bundle ID to locate an app capable of opening a particular file, using the first app it finds with the given
identifier. The bundle ID is also used to validate an app’s signature.

The bundle ID string must be a uniform type identifier (UTI) that contains only alphanumeric characters
(A-Z,a-z,0-9), hyphen (-), and period (.). The string should be in reverse-DNS format. For example, if your
company’s domain is Ajax.com and you create an app named Hello, you could assign the string
com.Ajax.Hello as your app’s bundle ID.

Configuring Your Xcode Project for Distribution
Configuring Identity and Team Settings
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During the development process, you use an app’s bundle ID in many different places to identify the app.

Bundle ID

Xcode project

iTunes Connect

iCloud
container ID

App ID

Specifically, the bundle ID is located and used as follows:

 ● In the Xcode project, the bundle ID is stored in the information property list file (Info.plist). This file
is later copied into your app’s bundle when you build the project.

 ● In Member Center, you create an App ID that matches the app’s bundle ID. If the App ID is an explicit App
ID, it exactly matches the bundle ID. However, unlike domain names, bundle IDs are case sensitive. If the
App ID is lowercase, your bundle ID needs to be lowercase, too.

 ● In iCloud, the container IDs you specify in your Xcode project are based on the bundle IDs of one or more
apps.

 ● In iTunes Connect, you enter the bundle ID to identify your app. After your first version is available on the
store, you can’t change your bundle ID.

Note:  A Mac app and an iOS app can’t share the same bundle ID.

Setting the Bundle ID
The default bundle ID in your Xcode project is a string formatted as a reverse-domain—for example,
com.MyCompany.MyProductName. To create the default bundle ID, Xcode concatenates the company identifier
with the product name you entered when creating the project from a template, as described in “Setting
Properties When Creating Your Xcode Project” (page 22). (Xcode replaces spaces in the product name to create
the default bundle ID.) It may be sufficient to replace the company identifier prefix in the bundle ID or you can
replace the entire bundle ID. For example, change the company identifier prefix to match your company domain
name or replace the entire bundle ID to match an explicit App ID.

Follow these steps to change the bundle ID prefix in the General pane in the project editor.
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To set the bundle ID prefix

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Identity to reveal the settings.

3. Enter the bundle ID prefix in the “Bundle Identifier” field.

Alternatively, follow these steps to change the entire bundle ID in the Info pane in the project editor.

To set the bundle ID

1. In the project navigator, select the project and your target to display the project editor.

2. Click Info.
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3. Enter the bundle ID in the Value column of the “Bundle identifier” row.

For Mac apps, ensure that every bundle ID is unique within your app bundle. For example, if your app bundle
includes a helper app, ensure that its bundle ID is different from your app’s bundle ID.

Choosing a Signing Identity for Mac Apps
You select the signing identity for Mac apps. You have the choice of submitting your app to the store, signing
it with a Developer ID certificate to distribute it outside of the store, or not code signing it at all:

 ● Select Mac App Store if you plan to submit your app to the store.

 ● Select Developer ID if you plan to distribute your Mac application outside of the store and not use Apple
services.

 ● Select None if you don’t want to sign your application or use Apple services.

If you select Mac App Store, you assign your Xcode project to a team and can add capabilities, as described in
“Adding Capabilities” (page 54). If you select Developer ID, you assign your Xcode project to a team but can’t
use any capabilities in your application (read “Distributing Applications Outside the Mac App Store” (page 217)
for how to create a Developer ID-signed application). If you select None, the Team pop-up menu is disabled
and you don’t need to read this guide.

To select a signing identity

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Identity to reveal the settings.
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3. Select the type of signing identity you want to use.

Assigning the Xcode Project to a Team
Each Xcode project is associated with a single team. If you enroll as an individual, you’re considered a one-person
team. The team account is used to store the certificates, identifiers, and profiles needed to provision your app.
All iOS apps and some Mac apps need to be code signed and provisioned to run on a device and use certain
services. Xcode creates these assets for you when needed, but you can avoid warnings and dialogs later if you
set the team now.

To assign the project to a team

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Identity to reveal the settings.

3. Choose your team from the Team pop-up menu.
 ● If you’re an individual, choose your name from the pop-up menu.
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 ● If you’re a company, choose your company name from the pop-up menu.

Xcode may attempt to create a team provisioning profile if you have a device connected or have
previously registered a device. To resolve issues related to the team provisioning profile, read “Creating
the Team Provisioning Profile” (page 31).

4. If a team doesn’t appear in the Team pop-up menu, choose “Add an Account” and follow the steps
described in “Adding Your Apple ID Account in Xcode” (page 18).
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Creating the Team Provisioning Profile
After you select a team, Xcode may attempt to create your code signing identity and a development provisioning
profile. Xcode creates a specialized development provisioning profile called a team provisioning profile that it
manages for you. A team provisioning profile allows an app to be signed and run by all team members on all
their devices. If Xcode fails to create the team provisioning profile, a warning and Fix Issue button appear
below the Team pop-up menu.

To create the team provisioning profile, Xcode performs these steps:

1. Requests your development certificate

2. Registers the iOS device chosen in the Scheme pop-up menu or your Mac

3. Creates an App ID that matches your app’s bundle ID and enables services

4. Creates a team provisioning profile containing these assets

5. Sets your project’s code signing build settings accordingly

Important:  If you are a team member for a company account, ask your team agent or admin to register
your Mac on your behalf, as described in “Registering Team Member Devices” (page 143). Also, ask the team
agent or admin to follow these steps to create the team provisioning profile if it doesn’t already exist. To
download the team provisioning profile to your Mac, refresh provisioning profiles, as described in “Refreshing
Provisioning Profiles in Xcode” (page 199), or click the Fix Issue button under the Team pop-up menu.

You can assist Xcode and avoid common problems by creating the team provisioning profile now.
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To create a team provisioning profile

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Identity to reveal the settings.

3. Verify that your bundle ID is unique by using a unique prefix.

Depending on your project’s configuration, Xcode may create either a wildcard App ID or an explicit
App ID. Because Xcode uses the bundle ID to register an explicit App ID, the bundle ID also needs to
be unique during development. To avoid an App ID registration error, enter a unique bundle ID now,
as described in “Setting the Bundle ID” (page 26).

4. For iOS apps, connect an iOS device you want to use for development and choose the device from the
destination Scheme pop-up menu.

Xcode requires one or more registered devices in your account before it can create a team provisioning
profile. If you connect an iOS device to your Mac that’s enabled for development, Xcode registers the
device for you. For Mac apps, Xcode automatically registers the Mac that’s running Xcode. You can
skip this step if you previously registered a device.

If your iOS device doesn’t appear in the destination Scheme pop-up menu, enable it for development
using the Devices organizer, as described in “Registering Devices Using Xcode” (page 188).

5. For Mac apps, select Mac App Store as the signing identity.

If you select Developer ID or None as the signing identity, you don’t use a team provisioning profile.

6. If necessary, choose your team from the Team pop-up menu.

7. If a Fix Issue button appears below the Team pop-up menu, click it.
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Xcode starts performing all the steps needed to create a team provisioning profile for your app.

8. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

9. If other dialogs or warnings appear, use the information to correct the problem and click Fix Issue
again.

After Xcode creates the team provisioning profile, the warning message under the Team pop-up menu should
disappear.

Setting the Mac Application Category
Set the category under which your app will be listed on the Mac App Store. The category you select should
match the category you later select in your iTunes Connect app record.

To set the application category

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Identity to reveal the settings.
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3. Choose the category from the Application Category pop-up menu.

iOS app categories are set in iTunes Connect only. For more details on app categories, read “Best Practices” in
iTunes Connect Developer Guide .

Setting the Version Number and Build String
The version number is a two-period-separated list of positive integers, as in 4.5.2. The first integer represents
a major revision, the second a minor revision, and the third a maintenance release. The version number is
shown in the store and that version should match the version number you enter later in iTunes Connect. For
details on possible values, see “CFBundleShortVersionString” in Information Property List Key Reference .

The build string represents an iteration (released or unreleased) of the bundle and can contain a mix of characters
and numbers, as in 12E123. For Mac apps, the user can click the version number in the About window to
toggle between the version number and the build string. For details on possible values, see “CFBundleVersion”
in Information Property List Key Reference .

For iOS apps, update the build string whenever you distribute a new build of your app for testing. iTunes will
recognize that the build string changed and properly sync the new iOS App Store Package to the device. For
how to configure your app for testing, read “Beta Testing Your iOS App” (page 91).

Set the version number and build string in the General pane in the project editor.

To set the version number and build string

1. In the project navigator, select the project and your target to display the project editor.
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2. Click General and, if necessary, click the disclosure triangle next to Identity to reveal the settings.

3. Enter the version number in the Version field, and enter the build string in the Build field.

Setting Deployment Info
The default deployment settings are sufficient for development but it’s best to review these settings before
you distribute your app. Some settings must match values you enter in iTunes Connect later. For iOS apps, the
deployment settings appear as shown here:
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Setting the Deployment Target
The deployment target setting specifies the lowest operating system version that your app will run on. For
example, the lowest available setting for iPad apps is iOS 4.3.

There are several strategies for choosing the deployment target when developing your app. Each version of
iOS or OS X includes features and capabilities not present in earlier versions. As new versions are published,
some users may upgrade immediately, while other users may wait before moving to the latest version. You
can target the latest version, taking full advantage of all the new features but limiting the app to only users
running the latest version. Or you can target an earlier version, making your app available to more users but
limiting the features you can use in the app. Another approach is to target an earlier version but use weak
linking to determine at runtime whether later version features are available before using them.

For details on weak linking, read “Weak Linking and Apple Frameworks” in SDK Compatibility Guide .

To set the target version

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Deployment Info to reveal the
settings.

3. Choose the version you want to target from the Deployment Target pop-up menu.

Xcode sets the Minimum System Version key in the app’s information property list to the deployment target
you choose. When you publish your app to the store, it uses this property value to indicate which versions
your app supports.
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Note:  The SDK version, not the deployment target, determines which features you can use in an
app. If the SDK you’re using to build the app is more recent than the app’s deployment target, Xcode
displays build warnings when it detects that your app is using a feature that’s unavailable in the
deployment target.

Ensure that the symbols you use are available in the app’s runtime environment. To check for their
availability, use the techniques described in SDK Compatibility Guide .

Setting the Target iOS Devices
The Devices setting identifies the type of devices you want an iOS app to run on. There are two device types:
iPhone and iPad. The iPhone type includes iPhone and iPod touch devices. The iPad type includes all iPad and
iPad mini devices.

To set the target devices

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Deployment Info to reveal the
settings.

3. From the Devices pop-up menu, choose iPhone, iPad, or Universal (to target both families).

For more information on configuring your app for iPhone, iPad, or both device families, see “Advanced App
Tricks” in iOS App Programming Guide .
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Adding App Icons and Launch Images
App icons and launch images are stored in the app bundle, not uploaded as separate assets to iTunes Connect.
The operating system uses these images in various locations on a device to represent your app. In general,
artwork displayed by the operating system resides in the bundle, and artwork displayed by iTunes is uploaded
to iTunes Connect. Your app needs an app icon to represent it and pass validation tests.

You can use an asset catalog that manages the app icons and launch images for you or maintain individual
image files yourself. If you create a new project, asset catalogs are used by default to store app icons and launch
images. If you have an older project, you can migrate from managing individual image files to an asset catalog.

To learn more about creating and managing asset catalogs, read Asset Catalog Help .

Preparing Your Artwork
For all artwork, keep the file size as small as possible for a positive purchase experience for your users.

For iOS apps, see “Icon and Image Sizes” in iOS Human Interface Guidelines for the sizes of all required app
icons, launch images, and other icons. Read “App Icons” in iOS App Programming Guide to create app icon files
for different iOS device resolutions.

On iOS, launch images are displayed while your app is launching. A launch image matching the device resolution
appears as soon as the user taps your app icon. Use screenshots to create your app’s launch images. To take
advantage of Retina displays, provide high-resolution images for each device you support.

For the required Mac app icons, see “Creating Great Icons for Any Resolution” inOSXHuman Interface Guidelines .
This table includes icon sizes that may be used on the Mac App Store. Read “Provide High-Resolution Versions
of All App Graphics Resources” in High Resolution Guidelines for OS X to create your app icon files.

For the specification of screenshots and other artwork that you upload later using iTunes Connect, read “iTunes
Connect App Properties” in iTunes Connect Developer Guide .

Migrating Your Images to an Asset Catalog
You can migrate your image files to an asset catalog that manages your app icons and launch images for you.
Xcode moves the image files from the tables to the new asset catalog.

To migrate to an asset catalog

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to either App Icons or Launch Images.

3. Click the Use Asset Catalog button.
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If a Source pop-up menu appears with an arrow button to the right, you are already using an asset
catalog and can skip these steps.

4. Optionally, select the checkbox to include launch images in the migration.

5. Click the Migrate button.

To view the asset catalog, click the arrow button to the right of the Source pop-up menu in the App Icons or
Launch Images section.

Adding App Icons to an Asset Catalog
Versions of your app icons are organized into image sets in an asset catalog. Xcode automatically creates image
sets for the app’s target device—for example, both iPhone and iPad image sets appear if your iOS app’s target
is universal.

To add an app icon to an asset catalog

1. In the project navigator, click the arrow button in the App Icons section of the General pane.
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2. In the Finder, drag an app icon to the image well that matches its resolution in the project navigator.

Capturing iOS Screenshots and Setting Launch Images
Follow these steps to capture screenshots of your app while your device is connected to your Mac.

Note:  Although the launch image includes the status bar as it looked when the screenshot was
captured, iOS replaces it with the current status bar when your app launches.

To capture a screenshot on your iOS device

1. Connect the device to your Mac.

2. On the device, configure the screen the way you want it.

3. In Xcode, choose Window > Organizer, and click Devices to display the Devices organizer.

4. In the Devices organizer, select Screenshots under the device.
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5. Click New Screenshot.

After you capture a screenshot, you can make it your app’s launch image using the Devices organizer.

To set a screenshot as your iOS app’s launch image

1. In the Devices organizer, select Screenshots for a device or in the Library section.
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2. Select an image.

3. Click “Save as Launch Image.”
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4. Enter a name for the image, select a workspace, and click Next.

5. If you have multiple targets in your project, select a target and click Finish.

To add the image to your asset catalog, drag it from the project folder to the appropriate image well in the
asset catalog, as described in “Adding Launch Images to an Asset Catalog” (page 44). To place a PNG file of
the screenshot on your desktop, drag it from the Devices organizer to the desktop.

Capturing iOS Screenshots Directly on Your Device
Alternatively, you can capture screenshots directly on your device and import them into your Mac using the
iPhoto app.

To capture a screenshot on your device, you press the Lock and Home buttons simultaneously. Your screenshot
is saved in the Saved Photos album in the iPhoto app.

Copy the screenshot from the device to your Mac and follow the steps in “Adding Launch Images to an Asset
Catalog” or “Setting Individual Launch Image Files” (page 47) to set the launch image.
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Adding Launch Images to an Asset Catalog
If you use an asset catalog to store your launch images, versions of your launch images are organized into
image sets. Xcode automatically creates image sets for the app’s target device—for example, both iPhone and
iPad image sets appear if your iOS app’s target is universal.

To add a launch image to an asset catalog

1. In the project navigator, click the arrow button in the Launch Images section of the General pane.

2. In the Finder or project folder, drag a launch image to the image well that matches the image resolution
in the project navigator.
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Setting Individual App Icon Files
If you don’t want to use an asset catalog, select “Don’t use asset catalogs” from the Source pop-up menu in
the App Icons section of the General pane.

If you are not using an asset catalog, a Use Asset Catalog button appears and the individual app icon files are
listed in the App Icons section of the General pane in the project editor. For iOS apps, the list of app icons
depends on the app’s target device—for example, both iPhone and iPad icons appear in the list if your iOS
app’s target is universal.

The screenshot below shows the app icons for an iOS app. A warning icon and message appear next to an app
icon that has no image.
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The screenshot below shows the single App Icon well for a Mac app. If you don’t use an asset catalog, the Mac
app icon file needs to be in ICNS format.

Provide app icons for all the OS versions and devices you support.

To add an app icon using the file picker

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to App Icons.

3. Click the file picker icon in the row of the app icon size you want to set.
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A file picker sheet appears.

4. Select an image file in your project folder or anywhere on your Mac, and click Add.

Setting Individual Launch Image Files
If you don’t want to use an asset catalog, select “Don’t use asset catalogs” from the Source pop-up menu in
the Launch Images section of the General pane. If a Use Asset Catalog button appears, you are not using an
asset catalog.
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If you are not using an asset catalog, individual launch image files are listed in the Launch Images section of
the General pane in the project editor. The list of images depends on the app’s target device and supported
device orientations. The text “No image specified” appears in the Resource column for a kind of device that
has no launch image.

Provide launch images for all the iOS versions and devices you support.

To set launch images in the project editor

1. In the project navigator, select the project and your target to display the project editor.

2. Click General and, if necessary, click the disclosure triangle next to Launch Images.

3. Click the file picker icon in the row of the launch image you want to set.
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A file picker sheet appears.

4. Pick an image file in your project folder or anywhere on your Mac, and click Add.

The filename appears in the Resource column and row of the launch image.

Setting the Copyright Key for Mac Apps
Make sure that your information property list file contains a valid value for the Copyright key. For details on
possible values, see “NSHumanReadableCopyright” in Information Property List Key Reference .

To edit the copyright key in the information property list

1. In Xcode, select the project in the project navigator.

2. Click the disclosure triangle next to the ProjectName folder to reveal its contents.

3. Click the disclosure triangle next to the Supporting Files subfolder to reveal its contents.

4. Select the ProjectName-Info.plist file.
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The information property list is displayed to the right in a property list editor.

5. Double-click in the Value column and in the row of the Copyright key.

6. Enter a new value for the key.

For how to edit other cells in a property list, refer to Property List Editor Help .

Verifying Your Build Settings
If you changed the default build settings, verify some of the settings before submitting your app to the store.
You do this in the Build Settings pane of the project editor.

To edit a build setting

1. In the project editor, select the project or target whose build setting you want to edit.
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2. Click Build Settings at the top of the project editor.

3. Locate the build setting in the left column, or enter the name of the build setting in the search field in
the upper-right corner.

4. If some build settings don’t appear, click All.

5. Set the value for the build setting in the right column.

Setting Architectures for iOS Apps
The Architectures build setting identifies the architectures for which your app is built. An iOS device uses a set
of architectures, which include armv7 and armv7s. You have two options for specifying the value of this
setting:

 ● Standard. Produces an app binary with a common architecture, compatible with all supported iOS devices.
This option generates the smallest app, but it may not be optimized to run at the best possible speed for
all devices.

 ● Other. Produces an app binary for a specified set of architectures.

If you select Other from the Architectures build-setting value list, click the Add button (+) to enter the custom
iOS-device architecture names you support.
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Important:  The store rejects a binary that supports only armv7s. If armv7s is included in the Valid
Architectures list, armv7 must also be included.

Setting the Base SDK
The Base SDK version number must be greater than or equal to the software version number on your
development device; otherwise, Xcode can’t initiate a debugging session with the device. Set the Base SDK
for your project and targets to the latest operating system, which is the default value. The Base SDK property
is located in the Architectures area in the Build Settings pane. For iOS apps, set Base SDK to Latest iOS. For Mac
apps, set Base SDK to Latest OS X. If you select another value, download and install the latest SDK version that’s
greater than or equal to your device software version.

To go to the Architectures area, select the project or target and click Build Settings. The Architectures area
appears first in the Build Settings pane.
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Setting the Debug Information Format
Set the Debug Information Format build setting to “DWARF with dSYM”. This is required to symbolicate crash
reports, as described in “Analyzing Crash Reports” (page 107).

Recap
In this chapter, you learned how to configure your Xcode project from a template, set the app’s identity
information, and create a team provisioning profile for development. During development, refer to this chapter
as needed. Later, use this chapter as a checklist for the settings that are required by the App Store and Mac
App Store.
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Certain technologies and services—such as iCloud and push notifications—are available only to apps distributed
through the store and require additional configuration in your Xcode project, Member Center, and sometimes
iTunes Connect. Some technologies and services are for certain types of apps, such as games and Newsstand
apps, and provide additional sources of revenue, such as In-App Purchase and iAd Network.

Apple implements an underlying security model to protect both user data and your app from being modified
and distributed without your knowledge. Hence, your app is code signed and provisioned to use only the key
Apple technologies and services that you specify. When you add capabilities to your app using Xcode, Xcode
automatically configures your project to use them. Xcode edits the entitlements and information property list
files for you and adds technology-specific frameworks as needed. For entitlements to take effect, Xcode creates
code signing and provisioning assets for your team and sets your code signing build settings for you. Xcode
creates a wildcard App ID and explicit App ID, if needed, to enable the technologies you choose. Some
technologies—such as Game Center and In-App Purchase—may require additional setup in Member Center
and iTunes Connect.

This chapter describes all the steps that you perform to access Apple services from your app.

About Entitlements
An entitlement is a single right granted to a particular app, tool, or other executable that gives it additional
permissions above and beyond what it would ordinarily have. The term entitlement is most commonly used
in the context of a sandbox, and to a lesser degree for an App ID. Regardless of the location, an entitlement is
a piece of configuration information included in your app’s code signature—telling the system to allow your
app to access certain resources or perform certain operations. In effect, an entitlement extends the sandbox
and capabilities of your app to allow a particular operation to occur.

You set some entitlements for an App ID in Member Center—for example, by enabling certain technologies
and services—and others in the Xcode project. The technologies enabled for an App ID serve as a white list
of the technologies one or more apps may use. Some technologies are enabled by default for an explicit App
ID. The Xcode project configuration specifies which technologies the app actually uses.
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Before You Begin
All of the options discussed in this chapter are located in the Capabilities pane in the project editor for your
target.

The screenshot below shows the Capabilities for an iOS app.

To open the Capabilities pane

1. Choose View > Navigators > Show Project Navigator.
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2. Choose the target from the Project/Targets pop-up menu or in the Targets section of the second sidebar
if it appears.

3. Click Capabilities to view key technologies and services you can add to your app.

Xcode creates code signing and provisioning assets for you as you need them but because some assets depend
on others, dialogs may appear asking you to fix problems while you enable capabilities. For example, you may
be asked to assign a team to your project, create a development certificate, and register a device so that Xcode
can create your team provisioning profile. A development provisioning profile is not required to enable
capabilities, but is required to build and launch an app that uses the capabilities. To avoid these dialogs and
warnings, create your code signing identity and team provisioning profile now, as described in “Creating the
Team Provisioning Profile” (page 31). Otherwise, read “Troubleshooting” (page 83) for how to resolve issues
as they occur.

Configuring App Sandbox for Mac Apps
Sandboxing provides the last line of defense against stolen, corrupted, or deleted user data if malicious code
exploits your app. Sandboxing also minimizes damage from coding errors in your app or in frameworks you
link against. Simply enabling sandboxing provides the maximum level of restrictions on how an app can interact
with the rest of the system. All apps submitted to the Mac App Store are required to use sandboxing. Therefore,
if you plan to submit your app to the Mac App Store, enable sandboxing during development.

You configure sandboxing by enabling this feature and then optionally granting permission for specific types
of functions.
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To configure App Sandbox

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.

3. If App Sandbox isn’t enabled, select the switch in the App Sandbox row.

Xcode adds an entitlements file to your project and automatically enters default values for some
entitlements. Xcode also enables the App Sandbox entitlement.
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4. Use the App Sandbox checkboxes in this area to describe the minimum set of capabilities the target
needs to do its job.

You can set specific permissions for file types, too. To set the access for a file type, choose a permission from
the pop-up menu in the row that best describes the file type.

For a complete description of App Sandbox entitlements, refer to Entitlement Key Reference . If you’re enabling
sandboxing for an existing app, read App Sandbox Design Guide to learn the locations that a sandboxed app
can access.

Adding iCloud Support
iCloud storage allows you to share a user’s data among multiple instances of your app running on different
iOS devices and Macs. Your app needs to be provisioned to use iCloud, which includes setting entitlements in
your Xcode project.
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Enabling iCloud
Before you can configure iCloud key-value storage or iCloud document storage, you enable iCloud in Xcode.

To enable iCloud

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.

3. If iCloud isn’t enabled, select the switch in the iCloud row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

Xcode automatically provisions your app to use iCloud.

Configuring iCloud Key-Value Storage
iCloud key-value storage allows an app to share small amounts of data with other instances of itself running
on the user’s other devices.

To configure iCloud key-value storage

1. In the project editor, click Capabilities and, if necessary, click the iCloud disclosure triangle.

2. Select “Use key-value store.”
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The identifier defaults to your bundle ID.

3. If you want to change the identifier, double-click your bundle ID and enter a new identifier in the
Ubiquity Containers area.

For most apps, the default value is what you want. However, if your app shares its key-value storage
with another app, you must specify the bundle identifier for the other app instead.

To learn how to use iCloud key-value storage for preferences, read iCloud Design Guide .

Configuring iCloud Document Storage
iCloud document storage is used to store user documents and app data in the user’s iCloud account. Each app
has a container in the user’s iCloud account identified by its App ID. An app can access containers belonging
to other apps created by your team as well.

To configure iCloud document storage, add one or more iCloud containers. Add your bundle ID to the container
list or add a wildcard App ID to match a set of App IDs. The first container identifier can’t be a wildcard App
ID.

To add an iCloud container

1. In the project editor, click Capabilities and, if necessary, click the iCloud disclosure triangle.

2. Click the Add button (+) at the bottom of the Ubiquity Containers area.
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3. Enter the App ID for the container you want to add.

To delete a container, select it in the Ubiquity Containers area, and click the Delete button (–).

For guidance on selecting iCloud containers, read iCloud Design Guide .

Enabling Game Center
Game Center is Apple’s social gaming network. It allows players to connect their devices to the Game Center
service and to exchange information.

To use Game Center, first enable Game Center in Xcode.

To enable Game Center

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.
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3. If Game Center isn’t enabled, select the switch in the Game Center row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

Xcode automatically provisions your app to use Game Center and adds the Game Kit framework to your
project.

For Mac apps, Xcode also sets your Outgoing network entitlements in the App Sandbox section, located in the
Capabilities pane in Xcode. If your app also listens for network connections, it needs to allow incoming
connections. To set additional network entitlements, read “Configuring App Sandbox for Mac Apps” (page
56).

For how to write your Game Kit code, read Game Center Programming Guide . To configure your app in iTunes
Connect, read “Adding New Apps” in iTunes Connect Developer Guide to create the app record (enter your
explicit App ID), and read Game Center Configuration Guide for iTunes Connect to configure game features.

Enabling In-App Purchase
In-App Purchase embeds a store directly into your app by enabling you to connect to the store and securely
process payments from the user. You can use In-App Purchase to collect payment for enhanced functionality
or for additional content usable by your app. After configuring this technology in your Xcode project, you
configure it in iTunes Connect. You also use iTunes Connect to create your in-app purchases.
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To enable In-App Purchase

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.

3. If In-App Purchase isn’t enabled, select the switch in the In-App Purchase row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

Xcode automatically provisions your app to use In-App Purchase and adds the Store Kit framework to your
project for you.

For how to write your In-App Purchase code, read In-App Purchase Programming Guide . To create an app
record and enter the explicit App ID in iTunes Connect, read “Adding New Apps” in iTunes Connect Developer
Guide . To create in-app purchases, read In-App Purchase Configuration Guide for iTunes Connect .

Configuring Keychain Sharing
Enabling keychain sharing allows your app to share passwords in the keychain with other apps developed by
your team.

To enable keychain sharing

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.
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3. If Keychain Sharing isn’t enabled, select the switch in the Keychain Sharing row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

Xcode adds the keychain-access-groups key to the entitlements file.

If you want, you can restrict your app to a set of keychain access groups.

To limit your app to a set of keychain access groups

1. In the project editor, click Capabilities and, if necessary, click the Keychain Sharing disclosure triangle.

2. Click the Add button (+) at the bottom of the Keychain Groups area.
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3. Enter the keychain access group you want to add.

To delete a keychain access group, select it in the Keychain Groups area and click the Delete button (–).

Configuring Push Notifications
Apple Push Notification service (APNs) allows an app that isn’t running in the foreground to notify the user
that it has information for the user. Unlike other capabilities, you don’t configure push notifications in your
Xcode project. To enable push notifications, you create an explicit App ID that enables push notifications and
a corresponding client SSL certificate.

You can create only one explicit App ID that matches your bundle ID. Therefore, if Xcode created an explicit
App ID for you—for example, when you added another capability that requires an explicit App ID—you should
use it; otherwise, you create an explicit App ID that matches your bundle ID. You then generate and download
a corresponding client SSL certificate—this step fully enables push notifications—and refresh provisioning
profiles in Xcode. Later, you install the client SSL certificate and key on your server.

To learn more about using push notifications in your app, read Local and Push Notification Programming Guide .
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Locating Your App’s Explicit App ID
Normally, Xcode creates and manages App IDs for you. For example, if you enable iCloud first, Xcode creates
a wildcard App ID—either for iOS apps (Xcode iOS Wildcard App ID) or for Mac apps (Xcode Mac Wildcard App
ID). If you later enable Game Center or In-App Purchase, Xcode creates an explicit App ID. However, if you
disable Game Center, Xcode continues using the explicit App ID. So, first check Member Center to see if your
app has an explicit App ID.

To locate an explicit App ID

1. In Member Center, select Certificates, Identifiers & Profiles.

2. Under Identifiers, select App IDs.

3. Locate an App ID whose ID is the same as the bundle ID.

Compare the values in the ID column with the bundle ID that appears in the General pane in the Xcode
project editor. In Member Center, the name of an Xcode-managed explicit App ID begins with the text
“Xcode iOS App ID” or “Xcode Mac App ID.”

Creating an Explicit App ID
If no explicit App ID matches the bundle ID, create an explicit App ID, as described in “Registering App IDs” (page
181). When prompted to select services, select the Push Notifications checkbox and follow the steps in “Enabling
Push Notifications” to generate a client SSL certificate.

Adding Capabilities
Configuring Push Notifications

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

66

http://developer.apple.com/membercenter


Enabling Push Notifications
You enable push notifications when you create or edit an explicit App ID, but push notifications aren’t fully
enabled until you generate a client SSL certificate. A client SSL certificate allows your notification server to
connect to the APNs. Each App ID is required to have its own client SSL certificate. As with signing certificates,
you use separate client SSL certificates for development and production.

Create the development SSL certificate when you first enable push notifications and later return to Member
Center to create the production SSL certificate, as described in “Creating Push Notification Client SSL
Certificates” (page 174).

To enable push notifications

1. In Certificates, Identifiers & Profiles, select Identifiers.

2. Under Identifiers, select App IDs.

3. Select the explicit App ID and click Edit.

4. Scroll down and select the Push Notifications checkbox.
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5. Click Create Certificate under the type of SSL certificate you want to create.

6. Follow the instructions on the next webpage to create a certificate request on your Mac, and click
Continue.

7. Click Choose File.

8. In the dialog that appears, select the certificate request file (with a .certSigningRequest extension)
and click Choose.
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9. Click Generate.

10. Optionally, click Download.

You can also download the certificate from Member Center later.

11. Click Done.

Verifying Your Steps
Verify that the App ID enables push notifications.

To verify the App ID settings

1. In Certificates, Identifiers & Profiles, select Identifiers and under Identifiers, select App IDs.

2. Select the explicit App ID that matches the bundle ID.
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A green circle followed by Enabled appears in the Push Notifications row and Development or
Distribution column depending on the type of client SSL certificate you created earlier. A yellow circle
followed by Configurable in either the Development or Distribution column indicates a missing client
SLL certificate.

If a development SLL certificate is missing, read “Creating Push Notification Client SSL Certificates” (page 174)
to create it.

Refreshing Provisioning Profiles in Xcode
Changes you make using Member Center don’t automatically appear in Xcode. Therefore, refresh the provisioning
profiles in Xcode before you start using push notifications. Xcode creates a corresponding development
provisioning profile or regenerates an existing provisioning profile for you. An Xcode-managed provisioning
profile that uses an explicit App ID begins with the text “iOS Team Provisioning Profile:” or “Mac Team
Provisioning Profile:” followed by the bundle ID.
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To refresh provisioning profiles

1. In the Xcode Preferences window, click Accounts.

2. Select your team, and click View Details.
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3. In the dialog that appears, click the Refresh button in the lower-left corner.

4. If a dialog appears asking to create your distribution certificate, click Not Now or Request.

5. Click Done.

Verifying Your Steps
Use Member Center to verify that the provisioning profile was either created or regenerated to enable push
notifications.

To verify that a provisioning profile enables push notifications

1. In Certificates, Identifiers & Profiles, select Identifiers.

2. Under Provisioning Profiles, select Development.

3. Select the Xcode-managed provisioning profile that matches the bundle ID.
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Push notifications should appear in the “Enabled Services” list. (In-App Purchase and Game Center are
enabled by default for an explicit App ID.)

Installing Client SSL Certificates
For how to install the client SSL certificate and key on a server, read “Provisioning Procedures” in Local and
Push Notification Programming Guide . For techniques to resolve push notification server issues, read
Troubleshooting Push Notifications .

Configuring Maps
The Maps service allows apps to get directions or ask the Maps app to display directions. In addition, iOS apps
that are able to display point-to-point directions can register as routing apps and make those directions available
to Maps and other apps. For both iOS and Mac apps, you use Xcode to enable the Maps service. For iOS routing
apps, you use iTunes Connect to upload a geographic coverage file.

For how to write your MapKit framework code, read Location and Maps Programming Guide .

Enabling Maps in Xcode
Enable Maps in your Xcode project, and for iOS routing apps, select one or more supported modes.
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To enable Maps and select modes

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.

3. If Maps isn’t enabled, select the switch in the Maps row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

5. For iOS routing apps, select one or more supported modes from the checkboxes below.

You’re required to select one or more supported Routing modes.
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For iOS apps, Xcode adds necessary keys to your information property list, and adds the Map Kit framework
to your project. For Mac apps, Xcode adds a Maps entitlement to the App ID and adds the Map Kit framework
to your project.

Configuring an iOS Routing App
You perform additional steps to configure an iOS app that provides point-to-point directions for other apps.
Before continuing, review the tasks that you perform to configure an iOS routing app:

Task

Enable Maps in Xcode.

Select one or more supported modes in Xcode.

Write the code to provide routing directions.

Create an app record and optionally, upload your app’s geographic coverage file.

Upload a binary of your app to the store.

If necessary, upload your app’s geographic coverage file.

Providing Routing Directions
To learn how to create a routing app, read “Providing Directions” in Location and Maps Programming Guide .

Creating an App Record in iTunes Connect
To create an app record in iTunes Connect, follow the steps in “Adding New Apps” in iTunes Connect Developer
Guide . Routing apps must provide a geographic coverage file that defines the regions that your app supports.
You can upload the geographic coverage file when you create the app record, or later after you upload a binary,
as described in “Uploading the Geographic Coverage File to iTunes Connect” (page 75).

Submitting a Binary to the Store
To upload a binary to iTunes Connect, follow the steps in “Submitting Your App” (page 109).

Uploading the Geographic Coverage File to iTunes Connect
If you submit a binary for a routing app, Apple doesn’t start the approval process until you upload the geographic
coverage file.
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To upload the geographic coverage file after you submit your binary

1. Sign in to iTunes Connect.

2. On the iTunes Connect homepage, click Manage Your Apps.

3. Locate the app you want to edit, and click the large icon or app name.

4. Click View Details for the version of your app that you want to edit.

5. Click the Edit button that appears next to the Version Information section.

6. Click the Choose File button under Routing App Coverage File.

7. Locate the file and click Choose.

8. Click Upload File.

If the file isn’t formatted correctly, a message appears at the top of the page.

Configuring Passbook for iOS Apps
Passbook presents digital representations of information—such as a coupon, ticket for a show, or boarding
pass—that allow users to redeem a real-world product or service. You can use Passbook in several ways:

 ● To create, distribute, and update passes, register a pass type identifier and request a pass-signing certificate.
You don’t need an app or an entitlement to do this. For details, read Passbook Programming Guide .

 ● To let users add passes to Passbook from your app, use the Pass Kit framework. You don’t need to set
Passbook entitlements to do this.

 ● To access the user’s passes in your app, follow the steps below.

First, you enable Passbook in your Xcode project.

To enable Passbook

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.
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3. If Passbook isn’t enabled, select the switch in the Passbook row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

Xcode automatically provisions your app to use Passbook and adds the Pass Kit framework to your project.

Optionally, you can restrict your app to a subset of your pass type identifiers. This is especially useful if you
develop multiple apps that use passes.

If you don’t have a pass type identifier, create one before enabling this feature.

To create a pass type identifier

1. In Certificates, Identifiers & Profiles, select Identifiers.

2. Under Identifiers, select Pass Type IDs.

3. Click the Add button (+) in the upper-right corner.
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4. Enter a description and identifier, and click Continue.

5. Review the settings and click Register.

6. Click Done.

You can then use Xcode to restrict your app to a set of pass type identifiers.

To limit your app to using a subset of pass type identifiers

1. In the project editor, click Capabilities and, if necessary, click the Passbook disclosure triangle.

2. Select “Allow subset of pass types.”

If there are no pass type identifiers in Member Center, the radio button reverts to “Allow all team pass
types.”
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3. If necessary, click the Refresh button under the Pass Types list to display your pass type identifiers.

4. Select the pass type identifiers you want to use.

To use a pass type identifier in your app, read “Setting the Pass Type Identifier and Team ID” in Passbook
Programming Guide .

Configuring Background Modes for iOS Apps
Enabling background modes allows your app to continue running in the background.

To enable background modes

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.
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3. If Background Modes isn’t enabled, select the switch in the Background Modes row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

5. Optionally, select the supported modes from the checkboxes below.

Xcode adds the background modes to the information property list.

For guidance on selecting background modes, read “App States and Multitasking” in iOS App Programming
Guide .
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Enabling Inter-App Audio for iOS Apps
Inter-app audio allows your app to export audio that other apps can use.

To enable inter-app audio

1. In the project navigator, select the project and your target to display the project editor.

2. Click Capabilities.

3. If Inter-App Audio isn’t enabled, select the switch in the Inter-App Audio row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

Xcode automatically provisions your app to use inter-app audio and adds the Core Audio framework to
your project.

Enabling Data Protection for iOS Apps
Data protection adds a level of security to files stored on disk by your app. Data protection uses the built-in
encryption hardware present on specific devices to store files in an encrypted format on disk. Your app needs
to be provisioned to use data protection.

To enable data protection

1. In the project navigator, select the project and your target to display the project editor.
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2. Click Capabilities.

3. If Data Protection isn’t enabled, select the switch in the Data Protection row.

4. If a dialog appears asking whether Xcode should request a development certificate on your behalf,
click Request.

The default level of protection is complete protection , in which files are encrypted and inaccessible when the
device is locked. You can programmatically set the level of protection for files created by your app, as described
in “Protecting Data Using On-Disk Encryption” in iOS App Programming Guide .

Configuring Newsstand for iOS Apps
Newsstand enables an app to organize a user’s magazine and newspaper app subscriptions into a folder. To
use Newsstand, add some keys to the information property list and add artwork to your Xcode project. For
more information on creating a Newsstand app, refer to Newsstand for Developers. For how to add Newsstand
cover icons to your Xcode project, read “Newsstand Icons” in iOS Human Interface Guidelines .
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Troubleshooting
If there was a problem enabling a technology, an error message appears in that area of the project editor under
Steps. After reading the error message, click Fix Issue to repair the problem. If you have a development certificate
and for iOS apps, an iOS device chosen from the Scheme pop-up menu, Xcode can create your team provisioning
profile for you.

Recap
In this chapter, you learned how to configure key technologies and services in Xcode and, in some cases, in
Member Center and iTunes Connect.
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All iOS apps and most Mac apps must be code signed and provisioned to launch on a device. Provisioning is
the process of preparing and configuring an app to launch on devices and use certain services. Xcode uses
information you provide to create a team provisioning profile for you when you assign your Xcode project to
a team or the first time you add capabilities to your app. For example, Xcode offers to create your development
certificate and automatically registers a connected iOS device or your Mac. Xcode uses this information to
create a team provisioning profile that’s ultimately installed on the device. For iOS apps, Xcode runs an app
on a device (an iPad, iPhone, or iPod touch) if that device is in the provisioning profile. Similarly, a Mac app
that uses certain Apple services launches only if the Mac is in the provisioning profile.

To avoid issues later when you distribute your app, test your app on a device using the debug navigator, as
described in Debug Navigator Help , test navigator, as described in Test Navigator Help , and Instruments app,
as described in Instruments User Guide .

Launching Your iOS App on a Device
It takes just a few steps to launch your app on a device if you previously created your code signing identity
and team provisioning profile, as described in “Creating the Team Provisioning Profile” (page 31). Otherwise,
a series of dialogs and warnings may appear as Xcode resolves the code signing issues in the process of
launching your app.

To launch an iOS app on a device

1. Connect a device that’s enabled for development to your Mac.

2. In the project navigator, choose your device from the destination Scheme pop-up menu.
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Xcode assumes you intend to use the selected device for development and automatically registers it
for you. If the device doesn’t appear in the Scheme pop-up menu, enable it for development, as
described in “Registering Devices Using Xcode” (page 188).

3. Click the Run button.

Xcode installs the app on the device before launching the app.

4. If a prompt appears asking whether codesign can sign the app using a key in your keychain, click
Always Allow.

While developing your app, run and test it on all of the iOS devices and iOS versions that you intend to support.
Because different instruments are available in iOS Simulator, also test your app in iOS Simulator using Instruments
and other tools before distributing your app. For details on how to use iOS Simulator to test your app, read
iOS Simulator User Guide .

Launching Your Mac App
To launch your Mac app, click the Run button in the project navigator. Xcode automatically registers your Mac
and adds it to the team provisioning profile.
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Verifying Your Steps
To learn more about how Xcode provisions your app, examine the team provisioning profile in Member Center.
You can verify that the device was registered and added to the team provisioning profile.

To verify that your device is registered

1. In Certificates, Identifiers & Profiles, select Devices.

2. Under Devices, select All.

The device you registered should appear enabled in the list. Enabled devices appear in black text and
disabled devices appear in gray text.

To verify that your device is added to the team provisioning profile

1. In Certificates, Identifiers & Profiles, select Provisioning Profiles.

2. Under the Provisioning Profiles section, select All.
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The team provisioning profile, starting with the text “iOS Team Provisioning Profile” or “Mac Team
Provisioning Profile,” should appear under iOS Provisioning Profiles or Mac Provisioning Profiles.

You may have multiple team provisioning profiles depending on the capabilities you add and the
number of apps.

3. Click the team provisioning profile to view its details.

The team provisioning profile contains an App ID—either for iOS apps (Xcode iOS Wildcard App ID) or
for Mac apps (Xcode Mac Wildcard App ID). The screenshot below shows an iOS Provisioning Profile.
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Listed beneath the App ID is the number of development certificates and devices contained in the
provisioning profile. The values should equal the total number of iOS Development or Mac Development
certificates and enabled devices contained in your account. If you’re an individual, you should have
only one development certificate.

Troubleshooting
There are several reasons why your app may not run on a device.

 ● If the device doesn’t appear in the destination Scheme pop-up menu, enable it for development, as
described in “Registering Devices Using Xcode” (page 188).

 ● If a warning or error message appears below the Team pop-up menu in the General pane of the project
editor, follow the steps in “Creating the Team Provisioning Profile” (page 31) to fix the issue.

 ● Read “Adding Capabilities” (page 54), to fix similar provisioning errors in the Capabilities pane.

Assuming that you followed and verified the steps in this chapter, check the Xcode project settings. The
configuration of your project may not match the configuration of your device.

 ● To verify that the iOS Deployment Target is less than or equal to the iOS software version installed on your
device, read “Setting the Deployment Target” (page 36).

Team Provisioning Profiles in Depth
A team provisioning profile is a development provisioning profile that Xcode manages for you. A development
provisioning profile allows your app to launch on devices and use certain technologies during development.
For an individual, a team provisioning profile allows all apps signed by you to run on all of your registered
devices. For a company, a team provisioning allows any app developed by a team to be signed by any team
member and installed on any team device.

The team provisioning profile contains:

 ● A wildcard App ID that matches all your team’s apps or an explicit App ID that matches a single app

 ● All devices associated with the team

 ● All development certificates associated with the team

Launching Your App on Devices
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Xcode creates App IDs and team provisioning profiles as needed depending on the configuration and capabilities
of your app. Xcode adds all of the devices and development certificates from all team members to the team
provisioning profile. Thereafter, Xcode updates the team provisioning profile whenever you register a device,
create a development certificate, or modify the App ID. (Changes you make to your team assets using Member
Center don’t automatically update team provisioning profiles.)

If your app can use a wildcard App ID during development, Xcode creates a team provisioning profile named
iOS Team Provisioning Profile: * or Mac Team Provisioning Profile: * using a wildcard App ID it also creates. You
can use a wildcard App ID with iCloud and some other iOS-specific technologies. However, if you add a capability
that requires an explicit App ID—for example, Game Center or In-App Purchase—, Xcode creates an explicit
App ID and a corresponding team provisioning profile called iOS Team Provisioning Profile: or Mac Team
Provisioning Profile: followed by the bundle ID. Because an explicit App ID exactly matches the project’s bundle
ID, you can register only one explicit App ID per bundle ID. Therefore, if one already exists in Member Center,
Xcode uses it in the team provisioning profile instead of creating one for you.

This diagram shows an iOS Team Provisioning Profile using a wildcard App ID for a company with three team
members.

Launching Your App on Devices
Team Provisioning Profiles in Depth
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This diagram shows a Mac Team Provisioning Profile using an explicit App ID for a Mac company.

Team agents need to approve team member development certificates and devices before they’re added to
the team provisioning profile. If you enrolled as a company, read “Managing Your Team” (page 136) to learn
more about your responsibilities.

Recap
In this chapter, you learned how to use the team provisioning profile, which Xcode creates and manages for
you, to launch your app on devices. You learned what information Xcode needs to create the team provisioning
profile, how to verify that Xcode registered your devices, and how to troubleshoot if Xcode displays errors or
warnings.

Launching Your App on Devices
Recap
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You’ve created your iOS app in Xcode and added key technologies and services. You’ve tested your app on
iOS Simulator and your own devices. It’s time for beta testing. In this phase, you distribute the app to a wider
audience—to give the app a “real-world” test and, in some cases, to offer testers a preview of your next version.

To distribute your app for beta testing:

1. Optionally, create an iTunes Connect app record.

2. Register all test devices.

3. Create a distribution certificate.

4. Create an ad hoc provisioning profile.

5. Update the build string.

6. Archive and validate your app.

7. Create an iOS App Store Package.

8. Install the app on test devices.

9. Distribute your app to testers.

10. Solicit crash reports from testers.
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Important:  Rigorously test your app on a variety of devices and iOS versions. Because different kinds of
devices and iOS releases have different capabilities, it’s not sufficient to test your app on a device provisioned
for development or the simulator. iOS Simulator doesn’t run all threads that run on devices, and launching
apps on devices through Xcode disables some of the watchdog timers. At a minimum, test the app on all
devices you support and have available. In addition, keep prior versions of iOS installed on devices for
compatibility testing. If you don’t support certain devices or iOS versions, indicate this in the project target
settings in Xcode, as described in “Setting Deployment Info” (page 35).

About Ad Hoc Provisioning Profiles
An ad hoc provisioning profile is a distribution provisioning profile for iOS apps that allows your app to be
installed on designated devices and use key technologies and services without the assistance of Xcode. It’s
one of the two types of distribution provisioning profiles you can create for iOS apps. (You use the other type
of distribution provisioning profile later to submit your app to the store.) An ad hoc provisioning profile ensures
that test versions of your app aren’t copied and distributed without your knowledge.

When you’re ready to distribute your app to testers, you create an ad hoc provisioning profile specifying an
App ID that matches one or more of your apps, a set of test devices, and a single distribution certificate.

Each iOS device in an ad hoc provisioning profile is identified by its unique device ID (UDID). The devices you
register and add to a provisioning profile are stored by Member Center. Each individual or company can register
up to 100 devices per membership year for development and testing.

You sign the iOS App Store Package containing your app using the distribution certificate specified in the ad
hoc provisioning profile and distribute iOS App Store Package to testers.

Beta Testing Your iOS App
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Creating Your App Record in iTunes Connect
If you’re beta testing a final candidate for a release, be sure to validate the app before distributing it to testers.
The validation tests are performed by iTunes Connect, which checks whether your Xcode project is configured
correctly for the store. For example, it reports a problem if you’re missing required app icons. Your iTunes
Connect app record needs to be in the “Waiting for Upload” or later state to validate the archive. To create
your app record and change it to the “Waiting for Upload” state, read “Creating an App Record” (page 130)
before continuing.

Registering Test Devices
You must have one or more registered devices to create an ad hoc provisioning profile. To register test devices,
collect device IDs from testers and add them to Member Center.

Testers can get their device ID using iTunes. (They don’t need to install Xcode to do this.) Send the instructions
in “Locating iOS Device IDs Using iTunes” (page 192) to testers and ask them to send their device IDs to you,
or follow these steps to collect your own device IDs.

In Member Center, register one or more devices, as described in “Registering Devices Using Member
Center” (page 190).

Creating Distribution Certificates
You must create a store distribution certificate before you can create an ad hoc provisioning profile. If you
refresh provisioning profiles, as described in “Refreshing Provisioning Profiles in Xcode” (page 199), Xcode may
display a dialog asking if it should request a distribution certificate on your behalf. If you don’t click Request
when this dialog appears, you can request specific types of certificates using Accounts preferences in Xcode,
as described in “Requesting Signing Identities” (page 149). For iOS apps, request an iOS Distribution certificate.
For Mac apps, request both a Mac App Distribution and a Mac Installer Distribution certificate.

Creating Ad Hoc Provisioning Profiles
Now you’re ready to create an ad hoc provisioning profile, which allows testers to run your app on their device
without needing Xcode. To create an ad hoc provisioning profile, you select an App ID, a single distribution
certificate, and multiple test devices.

Beta Testing Your iOS App
Creating Your App Record in iTunes Connect
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To create an ad hoc provisioning profile

1. In Certificates, Identifiers & Profiles, select Provisioning Profiles.

2. Click the Add button (+) in the upper-right corner.

3. Select Ad Hoc as the distribution method, and click Continue.

4. Choose the App ID you used for development, that matches your bundle ID, from the App ID pop-up
menu, and click Continue.

If you used a team provisioning profile during development and the menu contains only the Xcode
iOS Wildcard App ID, select it. If the menu contains another Xcode-managed explicit App ID (it begins
with “Xcode” and contains your bundle ID), select that App ID. If you created your own App ID, select
that one.

5. Select the distribution certificate you want to use, and click Continue.

6. Select the devices you want to use for testing, and click Continue.

Beta Testing Your iOS App
Creating Ad Hoc Provisioning Profiles
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7. Enter a profile name, and click Generate.

Wait while Member Center generates the provisioning profile.

8. Click Done.

In Xcode, refresh the provisioning profiles to download the ad hoc provisioning profile, as described in
“Refreshing Provisioning Profiles in Xcode” (page 199). The ad hoc provisioning profile should now appear in
the Provisioning Profiles table on the view details dialog in Accounts preferences.

Updating the Build String
If you update the build string, as described in “Setting the Version Number and Build String” (page 34), iTunes
recognizes that the build string changed and properly syncs the new iOS App Store Package to test devices.

Beta Testing Your iOS App
Updating the Build String
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Archiving and Validating Your App
You create an archive of your app regardless of the type of distribution method you select. Xcode archives
allow you to build your app and store it, along with critical debugging information, in a bundle that’s managed
by Xcode. For example, if you distribute a build of your app to testers, archiving the debugging information
makes it easier to interpret crash reports that they send you later. After your app is released, you use the same
debugging information to decipher crash reports that you download from iTunes Connect.

Important:  Save the archive for every version of an app you distribute. You need the debugging information
stored in the archive to decipher crash reports later.

With archives, you can distribute the same build to the store that you distribute for testing. It’s important to
test the exact build that’s a candidate for release. Differences between Xcode build settings can cause bugs
that don’t appear during testing, because the binary being tested was built differently. By having Xcode make
an archive of your app, you can be sure you’re testing the exact same build of your app that you submit to
the store.

Follow these steps to archive and validate your app:

1. Review the Archive scheme settings.

2. Create an archive of your app.

3. Validate the archive.

Reviewing the Archive Scheme Settings
The first time you make an archive, review the Archive scheme settings to ensure that you don’t archive a
debug version of your app.

To review the Archive scheme

1. In the Xcode project editor, choose Product > Scheme > Edit Scheme to open the scheme editor.

Beta Testing Your iOS App
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2. Click Archive in the column on the left.

3. Choose Release from the Build Configuration pop-up menu, and click OK.

Creating an Archive
Next, create an archive of your app. Xcode stores this archive in the Archives organizer.

To create an archive

1. In the Xcode project editor, choose iOS Device or your device name from the Scheme toolbar menu.

You can’t create an archive of a simulator build. If an iOS device is connected to your Mac, the device
name appears in the Scheme toolbar menu. When you disconnect the iOS device, the menu item
changes to iOS Device.

2. Choose Product > Archive.

The Archives organizer appears and displays the new archive.

Xcode runs validation tests on the archive and may display a validate warning in the project editor. For example,
if you don’t set required app icons, as described in “Setting Individual App Icon Files” (page 45), an Info.plist
warning message appears. If this happens, fix the issue and create the archive again.

Beta Testing Your iOS App
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Running iTunes Connect Validation Tests
Optionally, upload your archive to iTunes Connect to run validation tests.

Since iTunes Connect will validate your archive when you submit it to the store, it’s best to validate your beta
version now to discover issues early. The app record in iTunes Connect must be in the “Waiting for Upload” or
later state for you to validate your app, as described in “Changing the Status to Enable Uploading” (page 131).
If you’re not ready to create your app record, you can skip this validation step.

To validate an archive

1. In the Archives organizer, select the archive.

2. Click the Validate button.

3. Enter your iTunes Connect credentials, and click Next.

If a dialog appears stating that no application record can be found, create an app record in iTunes
Connect before continuing.

Beta Testing Your iOS App
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4. Select the ad hoc provisioning profile you created in a previous step, and click Validate.

iTunes Connect runs validation tests.

5. Review validation issues found, if any, and click Finish.

Fix any validation issues, create a new archive, and validate it again. Validation errors don’t prevent you
from distributing your app for beta testing.

Troubleshooting
If Xcode doesn’t find signing identities, a dialog stating “No identities are available for signing” appears. Verify
that you have a distribution certificate and an ad hoc provisioning profile before continuing.

If your ad hoc provisioning profile doesn’t appear in the Provisioning Profile pop-up menu when you create
the iOS App Store Package, refresh the profiles in Xcode, as described in “Refreshing Provisioning Profiles in
Xcode” (page 199).

Creating an iOS App Store Package
Because testers don’t have Xcode to run your app, you want to create an iOS App Store Package that they
use to install your app on their device. You use Xcode to create an archive and generate an iOS App Store
Package (a file with a .ipa filename extension) from the archive.

Beta Testing Your iOS App
Creating an iOS App Store Package

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

99



To create an iOS App Store Package for testing on devices

1. In the Archives organizer, select the archive.

2. Optionally, click the Validate button.

If you’re close to submitting your app to the store, validate it now and fix any problems before
distributing it for final testing. For a complete list of issues you should fix before distributing your app,
read App Store Review Guidelines for iOS Apps .

3. Click the Distribute button.

Beta Testing Your iOS App
Creating an iOS App Store Package
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4. Select “Save for Enterprise or Ad Hoc Deployment,” and click Next.

Beta Testing Your iOS App
Creating an iOS App Store Package
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5. Choose your ad hoc provisioning profile from the Provisioning Profile pop-up menu, and click Export.

6. Enter a filename and location for the iOS App Store Package file, and click Save.

The file has an .ipa extension.

Note:  To send an iOS App Store Package to another team member, choose a development
provisioning profile from the Provisioning Profile pop-up menu when creating the package. The
development provisioning profile you choose—for example, the team provisioning profile—needs
to contain the team member’s device.

Troubleshooting
If Xcode doesn’t find signing identities, a dialog stating “No identities are available for signing” appears. Verify
that you have a distribution certificate and an ad hoc provisioning profile before continuing.

Beta Testing Your iOS App
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If your ad hoc provisioning profile doesn’t appear in the Provisioning Profile pop-up menu when you create
the iOS App Store Package, refresh the profiles in Xcode, as described in “Refreshing Provisioning Profiles in
Xcode” (page 199).

Installing Your App on Test Devices
Before you distribute your app to testers, follow the steps that testers use to install and run the app on their
devices. Use iTunes to install the app on a nondevelopment device. iOS extracts the embedded ad hoc
provisioning profile in your app and installs it on the device for you. Then test your app on the device.

Follow these steps to install the app on a testing device.

To install the app on a device

1. Connect the testing device to a Mac running iTunes.

If possible, don’t use a Mac that you use for development.

2. Double-click the iOS App Store Package file you created earlier (the file with the .ipa extension).

3. In iTunes, click the device button in the upper-right corner of the window.

4. Select the Apps button.

The app appears in the iTunes app list.

Beta Testing Your iOS App
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5. Under Apps, choose “Sort by Name” or “Sort by Kind” from the pop-up menu.

An Install or Remove button appears adjacent to the app.

6. If an Install button appears, click it.

The button text changes to Will Install.

7. Click the Apply button or the Sync button in the lower-left corner to sync the device.

The app is uploaded to the device so that the user can start testing.

Finally, send the iOS App Store Package file to testers along with the app installation instructions and the crash
report instructions, as described in “Soliciting Crash Reports from Testers.”

Soliciting Crash Reports from Testers
When an app crashes on a device, iOS creates a record of that event. The next time the tester connects the iOS
device to iTunes, iTunes downloads those records (known as crash logs) to the tester’s Mac. Testers should
send these crash logs to you along with any bug reports. Later, after your app is released, you can also retrieve
crash reports of your live app from iTunes Connect.

Tell testers how to retrieve crash reports from their devices and send them to you.

To send crash reports from a Mac

1. Connect the testing device to a Mac running iTunes.

iTunes downloads the crash reports to your Mac.

2. In the Finder, choose Go > Go to Folder.

3. Enter ~/Library/Logs/CrashReporter/MobileDevice.

4. Open the folder identified by your device’s name.

5. Select the crash logs named after the app you’re testing.

6. Choose Finder > Services > Mail > Send File.

7. In the New Message window, enter the developer’s address in the To field and appropriate text in the
Subject field.

8. Choose Message > Send.

9. To avoid sending duplicate reports later, delete the crash reports you sent.

Beta Testing Your iOS App
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To send crash reports from Windows

1. Enter the crash log directory for your operating system in the Windows search field, replacing
<user_name> with your Windows user name.

 ● For crash log storage on Windows, type:

C:\Users\<user_name>\AppData\Roaming\Apple
computer\Logs\CrashReporter/MobileDevice

 ● For crash log storage on Windows XP, type:

C:\Documents and Settings\<user_name>\Application Data\Apple
computer\Logs\CrashReporter

2. Open the folder named after your device’s name and send the crash logs for the app you’re testing in
an email message using the subject-text format <app_name> crash logs from <your_name>
(for example, MyTestApp crash logs from Anna Haro) to the app’s developer.

To learn how to interpret the reports when you receive them from testers, read “Analyzing Crash Reports” (page
107).

Distributing Your App Using the Xcode Service
After you perform the steps in this chapter to create an ad hoc provisioning profile and distribute your app
for beta testing, you can optionally setup an Xcode service to distribute your app. The Xcode service, available
in OS X Server, automates the integration process of building, analyzing, testing, and archiving your app. The
Xcode service also hosts a website that facilitates the distribution of product builds and archives to testers and
other team members. See Xcode Continuous Integration Guide for more information about using the Xcode
service to distribute versions of your app to testers.

Copying App Sandbox Data
To further diagnose an issue with your app, you can copy app data from an app sandbox on an iOS device to
your file system. You can also copy app data from your file system to an app sandbox on an iOS device.

Beta Testing Your iOS App
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Ad Hoc Provisioning Profiles in Depth
You signed the iOS App Store Package containing your app using the distribution certificate specified in the
ad hoc provisioning profile. The ad hoc provisioning profile was included in the app bundle when you built
and archived the app. Then you installed the app on a test device. The app successfully launches if the app’s
bundle ID matches the App ID, the signature matches the distribution certificate, and the device is in the device
list of the ad hoc provisioning profile.

Recap
In this chapter, you learned how to distribute your iOS app for beta testing on designated test devices. You
also received instructions to send to testers to install the beta version of your app and send crash reports to
you.

Beta Testing Your iOS App
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When an iOS or a Mac app crashes, the system creates a crash report that’s very useful for understanding what
caused the crash. Crash reports describe the conditions under which the app terminated, in most cases including
a complete stack trace for each executing thread.

After you distribute your app, routinely collect and analyze any crash reports.

Collecting Crash Reports
You may receive crash reports from multiple sources throughout the lifetime of your app. For iOS apps, you
can solicit crash reports from beta testers, as described in “Soliciting Crash Reports from Testers” (page 104).
Similarly, you can collect crash reports for Mac apps during testing. You can also download crash reports from
iTunes Connect for an app that’s released, as described in “Viewing Crash Reports” (page 134).

Analyzing Crash Reports
You analyze crash reports using Xcode. To add crash reports to the Devices organizer, drag the crash reports
to the Device Logs group in the Library section. You can then view information about the crash such as the
stack trace for each execution thread. Xcode automatically symbolicates crash logs that you import into the
Devices organizer. Xcode replaces memory addresses with human-readable function names and line numbers.

Important:  For Xcode to symbolicate crash reports (to add to the crash log information about the API
used), use Spotlight to index the volume containing your archived apps and their corresponding dSYM
files.

For Mac apps, be sure to analyze a crash report using a guest account with a fresh install of the version of OS
X that matches the crash report. Don’t analyze a crash report using a developer or admin system account,
because the problems you want to analyze may not occur.

For how to interpret an iOS crash report, read Understanding and Analyzing iOS Application Crash Reports .
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Make sure that test the exact same build that crashed. You should save all the archives that you distribute for
testing and submit to the store. For how to verify if your archive in Xcode matches a crash report, read How
to Match a Crash Report to a Build . Later, follow these same steps to determine if you’re testing the same build
that you submitted to the store.

Analyzing Crash Reports
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The final distribution step is to submit your code signed and provisioned app to the store. This important step
ensures that the submission comes directly from you and that only you grant permission for your app to use
key technologies and services. Code signing your app or installer package prevents an attacker from submitting
a modified version of your app to the store—only someone with the private key for your distribution certificate
can submit your app to the store.

Follow these steps to submit your app:

1. Create a distribution certificate.

2. Create a store distribution provisioning profile.

3. Archive and validate your app.

4. For Mac apps, test the Mac Installer Package.

5. Submit your app using Xcode or Application Loader.

For Mac apps, select Mac App Store as the signing method during development if you intend to distribute
your app on the Mac App Store, as described in “Choosing a Signing Identity for Mac Apps” (page 28). Mac
apps need a distribution provisioning profile only if the app uses key technologies and services, described in
“Adding Capabilities” (page 54), with the exception of App Sandbox.

About Store Provisioning Profiles
A store provisioning profile is a distribution provisioning profile that authorizes your app to use certain
technologies and services, and ensures that your app is submitted by you. A store distribution provisioning
profile contains a single App ID that matches one or more of your apps, and a distribution certificate. For iOS
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apps, you need a store provisioning profile to submit your app. For Mac apps, if you use technologies and
services that require provisioning, you need a store provisioning profile. If you don’t use these technologies
and services, you can use the distribution certificate to sign your app.

Configure the App ID before you create the store provisioning profile. You enable and configure technologies
for an app by setting entitlements and performing other configuration steps. Some entitlements are enabled
for an App ID (a set of apps created by your team) and others are set in the Xcode project. When you submit
your app to the store, you select the distribution certificate contained in your store provisioning profile.

Before You Begin
Before continuing, review the tasks that should be complete before you submit your first binary:

Task

Review your Xcode project configuration. Read “Configuring Your Xcode Project for
Distribution” (page 22).

To ensure that your app enables the key technologies and services you want to use, review your
App ID settings. Read “Adding Capabilities” (page 54).

For iOS apps, beta test your app on a variety of OS versions and devices. Read “Beta Testing
Your iOS App” (page 91).

Create an app record in iTunes Connect, as described in “Creating an App Record” (page 130).
To validate or submit your app, the app record needs to be in the “Waiting for Upload” or later
state.

Use the same App ID that you used for development and testing for submitting your app to the store. If you
don’t use any technologies and services, described in “Adding Capabilities” (page 54), that require an explicit
App ID, you can use the Xcode wildcard App ID. If you want to create a new App ID, read “Registering App
IDs” (page 181). However, if you change your App ID, retest your app using the new App ID before submitting
it to the store.

Submitting Your App
Before You Begin

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

110



Mac Note:  All apps and their installer packages need to be signed to submit them to the Mac App
Store. If you use a helper app, read Daemons and Services Programming Guide to learn how to
configure the helper app. All Mac apps need to have App Sandbox enabled, as described in
“Configuring App Sandbox for Mac Apps” (page 56).

To streamline the approval process, review the following guidelines and fix any problems before continuing.

 ● Follow the user interface guidelines in iOSHuman InterfaceGuidelines andOSXHuman InterfaceGuidelines .

 ● Review the store guidelines in App Store Review Guidelines for iOS Apps and App Store Review Guidelines
for Mac Apps .

Creating Distribution Certificates
You must create a store distribution certificate before you can create a store provisioning profile. If you did
not create a distribution certificate during development, you can create it now using Accounts preferences in
Xcode, as described in “Requesting Signing Identities” (page 149). For iOS apps, request an iOS Distribution
certificate. For Mac apps, request both a Mac App Distribution and Mac Installer Distribution certificate.

Creating Store Provisioning Profiles
Before submitting iOS apps to the store, you must provision them using a distribution provisioning profile. For
Mac apps, if you don’t use any key technologies and services that require provisioning (you didn’t need a
provisioning profile for development), you can skip this step. You don’t select any devices to create a store
provisioning profile.

To create a store provisioning profile

1. In Certificates, Identifiers & Profiles, select Provisioning Profiles.

2. Click the Add button (+) in the upper-right corner.

3. Select App Store for iOS apps or Mac App Store for Mac apps as the distribution method, and click
Continue.

Submitting Your App
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The screenshot below shows App Store selected for an iOS app.

4. Choose the App ID you used for development (the app ID that matches your bundle ID) from the App
ID pop-up menu, and click Continue.

Submitting Your App
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If you used a team provisioning profile during development and the menu contains only the Xcode
Wildcard App ID, select it. If the menu contains an Xcode-managed explicit App ID (it begins with
“Xcode” and contains your bundle ID), select that App ID. If you created your own App ID, select that
one.

5. Select your distribution certificate, and click Continue.

A store provisioning profile contains a single distribution certificate.

6. Enter a profile name, and click Generate.

Wait while Member Center generates the provisioning profile.

7. Click Done.

In Xcode, refresh the provisioning profiles to download the ad hoc provisioning profile, as described in
“Refreshing Provisioning Profiles in Xcode” (page 199). The store provisioning profile should now appear in the
Provisioning Profiles table in the view details dialog in Accounts preferences.

Submitting Your App
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Archiving and Validating Your App
Just before you submit your app to the store, you create a signed archive of your app and validate it. It’s
recommended that you submit the last archive you distributed for final testing. Test your final build before
submitting it to the store, and if you have not done so, test the archive again for regressions after validating
it.

Follow these steps to archive and validate your app:

1. Review the Archive scheme settings.

2. Create an archive of your app.

3. Validate the archive.

4. If necessary, test your archive before submitting it.

Important:  Archives allow you to build your app and store it, along with critical debugging information,
in a bundle that’s managed by Xcode. Save an archive for any version of an app you distribute to users.
You’ll use the debugging information stored in the archive to decipher crash reports later.

Reviewing the Archive Scheme Settings
If necessary, review the Archive scheme settings to ensure that you don’t archive a debug version of your app.

To review the Archive scheme

1. In the Xcode project editor, choose Product > Scheme > Edit Scheme to open the scheme editor.
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2. Click Archive in the column on the left.

3. Choose Release from the Build Configuration pop-up menu, and click OK.

Creating an Archive
No matter what method you choose to distribute your app, create an archive first. Before creating the archive,
build and run your app one more time to ensure that it’s the version you want to distribute. Immediately after
creating the archive, validate it and fix any validation errors before continuing.

To create an archive

1. In the Xcode project editor, select the project.

2. From the Scheme toolbar menu, choose a scheme.

iOS Note:  Choose iOS Device or the device name from the Scheme toolbar menu. You can’t
create an archive of a simulator build. If an iOS device is connected to your Mac, the device
name appears in the Scheme toolbar menu. When you disconnect the iOS device, the menu
item changes to iOS Device.

3. Choose Product > Archive.

The Archives organizer appears and displays the new archive.
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Xcode runs some validation tests when you create the archive. If a validate warning message appear in the
project editor, fix the issue and create the archive again.

Running iTunes Connect Validation Tests
Immediately after creating the archive, validate it and fix any validation errors before continuing.

Important:  You can’t validate your app unless the app record in iTunes Connect is in the “Waiting for
Upload” or later state, as described in “Creating an App Record” (page 130).

To validate an archive

1. In the Archives organizer, select the archive.

2. Click the Validate button.

3. For Mac apps, select Mac App Store as the validation method and click Next.

4. Enter your iTunes Connect credentials, and click Next.

If a dialog appears stating that no application record can be found, create an app record in iTunes
Connect before continuing.

5. Choose the store provisioning profile or, for some Mac apps, the distribution certificate you created in
a previous step from the Provisioning Profile pop-up menu, and click Validate.
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iTunes Connect runs validation tests.

6. Review validation issues found, if any, and click Finish.

Fix any validation issues you find, create a new archive, and repeat these steps until there are no further issues.
You can’t proceed until the archive passes all the validation tests.

Troubleshooting
After you enter your iTunes Connect credentials, if a dialog appears stating that no application record can be
found, create an app record in iTunes Connect before validating your app. To learn how to create an app record,
read “Creating an App Record” (page 130).

If your provisioning profile or Mac distribution certificate doesn’t appear in the Provisioning Profile menu when
you validate the archive, refresh the provisioning profiles, as described in “Refreshing Provisioning Profiles in
Xcode” (page 199).
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Testing the Mac Installer Package
Before you submit your app to the Mac App Store, test the installation process to verify that your app installs
correctly. Do this by saving the installer package to your disk and running a test using the installer command
before submitting it.

Creating an Installer Package
You save an installer package to your disk by following similar steps as for validating and distributing your
Mac app.

To create an installer package

1. In the Archives organizer, select the archive.

2. Click the Distribute button.

3. Select “Export as” for the distribution method, Mac Installer Package as the file format, and click Next.
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4. Choose the store provisioning profile or the distribution certificate you created in a previous step from
the “Profile or Signing Identity” pop-up menu, and click Export.

If you’re an individual, the name of the Mac Installer Distribution certificate is your name.

5. Enter a filename and choose a location from the dialog, and click Save.

Testing the Installer Package
Don’t test the installation process by opening the package with the Installer app. Only the installer command
verifies that your app will be installed correctly when it’s purchased from the Mac App Store.

To test your installer package, execute the following command in a Terminal window:

sudo installer -store -pkg path-to-package -target /

The output of the installer command should be similar to:

rpatel$ sudo installer -store -pkg ../Documents/TrackMix.pkg -target /

WARNING: Improper use of the sudo command could lead to data loss

or the deletion of important system files. Please double-check your

typing when using sudo. Type "man sudo" for more information.

To proceed, enter your password, or type Ctrl-C to abort.

Password:

installer: Note: running installer as an admin user (instead of root) gives better
Mac App Store fidelity

installer: TrackMix.pkg has valid signature for submission: 3rd Party Mac Developer
Installer: Ravi Patel (7U3X8B3P5Z)

installer: Installation Check: Passed

installer: Volume Check: Passed

installer: Bundle com.example.rpatel.TrackMix will be installed to
/Applications/TrackMix.app

installer: Starting install

installer: Install 0.0% complete

installer: Install 90.8% complete

installer: Install 100.0% complete
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installer: Finished install

rpatel$

If the installer finds a bundle with the same bundle ID as the one it’s installing, it upgrades the existing app.
Users can then install upgrades even if they have moved your app. If you have a copy of your app installed
(for example, in your build products directory), you may want to remove it so that the installer installs your
app in /Applications. Other options include archiving the existing version in a ZIP file or moving it to another
volume and unmounting that volume.

Submitting Your App Using Xcode
Submitting your app to the App Store or Mac App Store is just one of several types of distribution methods
you can choose. To submit your app using Xcode, select an archive and click the Distribute button in the
Archives organizer. In the first dialog that appears, you select the store distribution method. The following
dialogs and choices are slightly different for iOS and Mac apps.

If you prefer to upload your binary using Application Loader, read Using Application Loader for how to use
Application Loader for this step.

Important:  To submit your app, the app record in iTunes Connect must be in the “Waiting for Upload”
state or later, as described in “Creating an App Record” (page 130).

Submitting Your iOS App
For iOS apps, you select the “Submit to the iOS App Store” option when distributing your app.

To submit an archive to the App Store

1. In the Archives organizer, select the archive.

2. Click the Distribute button.
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3. Select “Submit to the iOS App Store,” and click Next.

4. Enter your iTunes Connect credentials, and click Next.

5. Choose the store provisioning profile you created in a previous step from the Provisioning Profile
pop-up menu, and click Submit.
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iTunes Connect runs validation tests.

6. If issues are found, click Cancel and fix them before continuing.

7. If no issues are found, click Submit to submit your app.

Xcode transmits the archive to Apple, where the binary is examined to determine whether it conforms to
the app guidelines. If the binary is rejected, correct the problems that were brought up during app approval
and resubmit it.

If you successfully submit your app, view the status of your app in iTunes Connect, as described in “Viewing
the Status of Your App” (page 130). After submitting your binary, Apple may discover other problems with your
app’s metadata in iTunes Connect that need to be fixed before Apple can review your app. If no problems are
found, the status of the app changes to “Waiting For Review.” To resolve any problems with your app record,
refer to iTunes Connect Developer Guide .
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Submitting Your Mac App
For Mac apps, you select the “Submit to the Mac App Store” option and choose the store provisioning profile
or distribution certificate. If your app uses key technologies and services, choose a store provisioning profile.

To submit an archive to the Mac App Store

1. In the Archives organizer, select the archive.

2. Click the Distribute button.

3. Select “Submit to the Mac App Store,” and click Next.

4. Enter your iTunes Connect credentials, and click Next.

5. Choose the store provisioning profile or the distribution certificate you created in a previous step, and
click Submit.
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If you use a store provisioning profile, choose the distribution certificate in your store provisioning
profile. Choose the signing identity that contains your team name. If you’re an individual developer,
your team name is the same as your name.

iTunes Connect runs validation tests.

6. If issues are found, click Cancel and fix them before continuing.

7. If no issues are found, click Submit to submit your app.

Xcode transmits the archive to Apple, where it’s examined to determine whether it conforms to the app
guidelines. If the app is rejected, correct the problems that were brought up during app approval and
resubmit it.

If you successfully submit your app, view the status of your app in iTunes Connect, as described in “Viewing
the Status of Your App” (page 130). After submitting your binary, Apple may discover other problems with your
app’s metadata in iTunes Connect that need to be fixed before Apple can review your app. If no problems are
found, the status of the app changes to “Waiting For Review.” To resolve any problems with your app record,
refer to iTunes Connect Developer Guide .
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Troubleshooting
After you enter your iTunes Connect credentials, if a dialog appears stating that no application record can be
found, create an app record in iTunes Connect before validating your app. To learn how to create an app record,
read “Creating an App Record” (page 130).

If your provisioning profile or, for some Mac apps, distribution certificate doesn’t appear in the Provisioning
Profile menu when you submit the archive, refresh the provisioning profiles, as described in “Refreshing
Provisioning Profiles in Xcode” (page 199).

Recap
In this chapter, you learned how to submit your app to the store using Xcode. This chapter doesn’t cover the
approval process. To learn how to view the status of your app, read “Viewing the Status of Your App” (page
130).
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After your app is approved, you release and maintain your app throughout the lifetime of the app on the store.
For example, you view crash reports, respond to customer reviews, and fix problems as needed. You’ll use
iTunes Connect to release, manage, and update versions of your app. This chapter provides an overview of a
few common tasks you’ll perform.

Check the status of your app. Use iTunes Connect to check the status of your app after you submit your app
and are waiting for approval, as described in “Viewing the Status of Your App” (page 130).

Enter sales and marketing information. Use iTunes Connect to prepare your app for purchase on the store,
as described in iTunes Connect Developer Guide .

Release your app. Use iTunes Connect to set the availability date, as described in “Changing the Availability
Date of Your App” (page 132).

View customer reviews. Customer ratings and reviews on the store can have a big effect on the success of
your app; if users run into problems, correct the bug and submit a new version of the app through the approval
process. To view customer reviews, read “Viewing Customer Reviews” (page 134).

View crash reports. Use iTunes Connect to download crash reports submitted to Apple by users. Crash reports
represent significant problems that users find in the app. To access and analyze these crash reports, read
“Viewing Crash Reports” (page 134) and “Analyzing Crash Reports” (page 107).

Update your app. You follow the same distribution process to submit updates to your app. In iTunes Connect,
you use the same app record but create a new version of your app. To update your app, read “Creating New
Versions of Your App” (page 135).

iTunes Connect provides data to help you determine how successful the app is, including sales and financial
reports, customer reviews, and crash logs submitted to Apple by users. Crash logs are particularly important,
because they represent significant problems that users are seeing in the app. It’s important to make investigating
these reports a high priority.
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iTunes Connect is a marketing and business web tool that iOS and Mac developers use to sign contracts, set
up tax and banking information, submit versions of their app, and obtain sales and finance reports. During
development, you enter metadata about your app, technologies that it uses, and any version information in
iTunes Connect. This chapter teaches you tasks you perform in iTunes Connect during development and
distribution to the store.

Initially, only the individual who joins the developer program has access to iTunes Connect. Because iTunes
Connect is primarily used to manage the business aspects of your app, and people performing those types of
tasks are typically not developers, you can tightly control access to iTunes Connect separately from your
Member Center account. For example, you can add nondeveloper iTunes Connect users and control access to
metadata by assigning roles and privileges.

iTunes Connect users with admin and technical roles perform a number of tasks, explained in this chapter, in
support of the development team and related to submitting your app to the store:

1. Add iTunes Connect users to give other team members access to iTunes Connect.

2. Create your app record so you can configure key technologies and services, and submit your app.

3. View the status of your app when you’re ready to submit it or waiting for approval.

4. Change the availability date of an app to release it.

5. View crash reports and customer reviews after your app is available.

6. Create a new version of your app.

For complete documentation on using iTunes Connect, refer to iTunes Connect Developer Guide .

About iTunes Connect User Roles and Privileges
The person who enrolls in the developer program—called the team agent—manages access privileges to
iTunes Connect. For example, changing the price of an app is a task you likely want to limit to a small number
of people in your organization. Access to the iTunes Connect tool is configured separately and is designed to
be more fine-grained than the access you set for team members. In iTunes Connect, each user can be assigned
one or more roles; each role has different privileges. Table 9-1 describes the roles at a high level.
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Table 9-1 iTunes Connect roles and responsibilities

ResponsibilitiesRole

The legal role is automatically assigned to the team agent, and only the team agent is
permitted to have this access. The legal role allows the team agent to sign legal contracts
and other agreements.

Legal

The admin role grants access to all tasks in iTunes Connect except for those assigned to
the legal role. A team agent is always assigned the admin role, and this access can’t be
revoked without changing which person on the team acts as the team agent. An admin
can assign iTunes Connect roles to other people on the team.

Admin

The technical role grants the ability to edit the app information stored in iTunes Connect
and to view test accounts for certain technologies and services.

Technical

The finance role grants access to financial reports and sales information. The finance role
also authorizes the person to view contract, tax, and banking information.

Finance

The sales role grants access only to sales data.Sales

Table 9-2 lists the most common modules (areas of iTunes Connect) you need to access, along with the roles
that have access to each module. The legal role isn’t shown, because only the team agent has those rights. All
participants can edit their own personal details stored in their accounts in iTunes Connect.

Table 9-2 Abbreviated list of iTunes Connect modules, including availability by role

SalesFinanceTechnicalAdminLegalResponsibility

Manage Users

Manage Test Users

Manage Your Apps

Sales and Trends

Tax and Banking

Contracts

Payments and Financial Reports

Catalog Reports

Managing Your App in iTunes Connect
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Accessing iTunes Connect
iTunes Connect is the repository for all store-related assets, including your app binaries. You use iTunes Connect
to market and distribute your app, check the status of your contracts, set up tax and banking information, get
sales and finance reports, and manage your app’s metadata. You can give another set of users access to your
iTunes Connect account. You access iTunes Connect from Member Center or by going directly to the iTunes
Connect website.

To go to iTunes Connect from Member Center

1. Sign in to Member Center.

2. Click the icon or text for iTunes Connect in the App Store Distribution section under Developer Program
Resources.

3. Enter your Apple ID and password, and click Sign In.

Adding iTunes Connect Users
To add an iTunes Connect user, read “Setting Up User Accounts” in iTunes Connect Developer Guide .

Managing Your App in iTunes Connect
Accessing iTunes Connect

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

129

https://itunesconnect.apple.com
https://itunesconnect.apple.com
http://developer.apple.com/membercenter


Creating an App Record
Certain technologies and services require you to create an app record and enter the bundle ID using iTunes
Connect during development. Later, you also need to create an app record in iTunes Connect to submit your
app to the store. When you’re ready to create your app record, read “Adding New Apps” in iTunes Connect
Developer Guide .

Viewing the Status of Your App
To submit your app to the store, the status of the app record needs to be “Waiting for Upload” or later. You
can view the status of your app in iTunes Connect.

To view the status of your app

1. Sign in to iTunes Connect.

2. On the iTunes Connect homepage, click Manage Your Apps.

3. Locate the app you want to edit, and click the large icon or app name.

Managing Your App in iTunes Connect
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The status of each version of your app appears below in the Versions section below the version number.

For details on each status, refer to “Viewing and Changing Your App’s Status and Availability” in iTunes Connect
Developer Guide .

Changing the Status to Enable Uploading
If you are ready to upload a binary—that is, validate or submit your app using Xcode—and the status of your
app version is “Prepare for Upload”, you need to provide more information to iTunes Connect to change the
status to “Waiting for Upload” before continuing.

To change the status from “Prepare for Upload” to “Waiting for Upload”

1. Sign in to iTunes Connect.

2. On the iTunes Connect homepage, click Manage Your Apps.

Managing Your App in iTunes Connect
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3. Under Versions, click View Details below the current version.

4. On the Versions Details page, click “Ready to Upload Binary.”

5. If a message appears at the top of the page indicating that additional configuration is required, resolve
the issue before continuing.

6. Then answer questions about Export Compliance, and if needed, upload encryption authorization
documents.

7. Click Save.

Changing the Availability Date of Your App
Use iTunes Connect to set a date when the app is available on the store. For example, you can choose a date
that immediately releases the app to the store after it’s approved, or you can set a later date. Using a later
availability date allows you to arrange other marketing activities around the launch of your app.

Managing Your App in iTunes Connect
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To set the availability date

1. Sign in to iTunes Connect.

2. Select Manage Your Apps.

3. Select your app in the Recent Activity section.

4. Click Rights and Pricing.

5. Choose a date from the Availability Date pop-up menus.

6. Optionally, edit the other fields in this form.

7. Click Save.

Changes you make to Rights and Pricing go live immediately (expect 24 hours for a full refresh of the
changes on the store).
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Viewing Crash Reports
All crash logs contain stack traces for each thread at the time of termination. To view a crash log, open it from
the Xcode Organizer window. As long as your Mac computer has the archive corresponding to the version of
the app that generated the crash log, Xcode automatically resolves any addresses in the crash log with the
actual classes and functions in the app.

You view and save crash reports in iTunes Connect from the version details page.

To view crash reports

1. Sign in to iTunes Connect.

2. On the iTunes Connect homepage, click Manage Your Apps.

3. Locate the app you want to edit, and click the large icon or app name.

4. Click View Details for the version of your app.

5. Click Crash Reports in the upper-right corner.

6. Click Refresh Now to retrieve any new available crash reports.

7. Select the crash report you want to view, and save the crash report you want to retain.

To view the crash reports in Xcode, follow the steps in “Analyzing Crash Reports” (page 107).

Viewing Customer Reviews
You view customer reviews in iTunes Connect in the same way that you view crash reports, described in
“Viewing Crash Reports” (page 134), except that you select Customer Reviews in the upper-right corner.
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To view customer reviews

1. Sign in to iTunes Connect.

2. On the iTunes Connect homepage, click Manage Your Apps.

3. Locate the app you want to edit, and click the large icon or app name.

4. Click View Details for the version of your app.

5. Select Customer Reviews under Links.

If this link isn’t displayed, customer reviews aren’t available for this version of your app.

Creating New Versions of Your App
To create new versions of your app, read “Replacing Your App with a New Version” in iTunes Connect Developer
Guide .

Recap
In this chapter, you learned how to grant access to iTunes Connect and perform common iTunes Connect tasks
performed by technical team members.
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If you have a company membership in an Apple Developer Program, you can add people to your team and
assign them roles, thereby granting them levels of access to team assets. Team members have roles and
privileges that pertain to the development process. These roles define who is allowed to sign apps, who is
allowed to create signing certificates, and so on. After adding team members, you may be responsible for
performing other tasks on their behalf. For example, you approve signing certificates and create provisioning
profiles for team members. If you’re an individual, you’re the team agent for your one-person team and don’t
perform any of the tasks described in this chapter.

Note:  Team members aren’t the same as iTunes Connect users. Only the person who joins the Apple
Developer Program initially has access to iTunes Connect. To learn how to add additional iTunes
Connect users, read “Managing Your App in iTunes Connect” (page 127).

About Apple Developer Program Team Roles and Privileges
A person’s role on the team defines the level of access that person has to the team’s assets and types of tasks
he or she can perform using developer tools. This privilege level extends to the kinds of tasks that a developer
is allowed to perform on behalf of the team. For example, only certain members of the team are allowed to
submit apps to the store. By giving you control over team roles, Apple makes it easier for you to maintain good
security practices for the team.

If your team belongs to multiple developer programs, you can set different team roles for each program. You
can also choose not to give someone access to a program.

Team Roles
Table 10-1 lists the roles a person can play and describes each. Each level of access includes all the capabilities
of the levels below it.
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Table 10-1 Team roles

DescriptionRole

A team agent is legally responsible for the team and acts as the primary contact with
Apple. The team agent can invite team members and change the access level of any
other team member. There’s only one team agent.

Team agent

A team admin can set the privilege levels of other team members, except the team
agent. Team admins manage all assets used to sign your apps, either during
development or when your team is ready to distribute an app. Team admins are the
only people on a team who can sign apps for distribution on nondevelopment devices.
Team admins also approve signing certificate requests made by team members.

Team admin

A team member can gain access to prerelease content delivered by Apple in Member
Center. A team member can also sign apps during development, but only after he or
she makes a request for a development signing certificate and has that request
approved by a team admin.

Team
member

Team Privileges
Each team role defines a set of privileges or tasks that a person can perform. Table 10-2 lists the specific
privileges granted to members of the team. The privileges are listed in chronological order to help guide you
through the process. Refer to Table 11-1 (page 166) for the types of certificates that each team member can
revoke.

Table 10-2 Privileges assigned to each membership level

Team

member

Team

admin

Team agentPrivilege

Have legal responsibility for the team

Be the primary contact with Apple

View prerelease Apple content

Enroll in additional developer programs and renew
them

Invite team admins and team members

Request development certificates
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Team

member

Team

admin

Team agentPrivilege

Approve team member requests for development
certificates

Request distribution certificates

For Mac apps, request Developer ID certificates

Add devices for development and testing

Create App IDs and enable certain technologies and
services

Create development and distribution provisioning
profiles

Create SSL certificates for Apple Push Notification
service

Download development provisioning profiles

Submit apps to the App Store or Mac App Store

Team Agent
To start, one person must enroll in either the iOS or the Mac Developer Program; this person becomes the
team agent for the team. The team agent may enroll in both programs if your team intends to develop apps
for both operating systems. During this step, the team agent signs the legal agreements required to become
an Apple developer and enters financial information so that the team can be paid for purchases of their app
from the store.

The team agent has an unrestricted role; he or she has unrestricted access to the team and is legally responsible
for the team. Initially, the team agent also performs most of the tasks to organize the team. After others have
joined the team, the team agent may decide to delegate some of this authority to other members of the team,
allowing those others to perform these tasks instead.

The team agent might need to sign updated or new licensing agreements, particularly when the team wants
to incorporate specific technologies into an app. For example, an app that uses the iAd service requires that
the team agent sign a separate agreement.
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Inviting Team Members and Assigning Roles
If you enroll as a company, you’re the de facto team agent who has permission to add other developers, called
teammembers , to your account. In general, team members have read access to view and download information
managed by Member Center—but they don’t have write access. However, you can assign an admin role to a
team member, which allows that person to have some of the privileges of a team agent—for example, a team
admin can create signing certificates and provisioning profiles but can’t sign agreements. Assigning roles helps
team agents delegate some of their responsibilities.

Inviting Team Members
When you invite people to join your team, you enter information about them and set their role on the team.

To invite team members

1. In Member Center, click People at the top of the webpage.

2. If necessary, click Invitations in the sidebar.

3. Click Invite Person.

4. Enter the first name, last name, and email address of the person you want to invite.
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5. Specify the person’s access and role for each program.

6. Click Send Invitation.

The person you specified receives an email invitation, which he or she must verify by clicking the
invitation code in it. If the person doesn’t have an Apple ID, he or she is asked to create one before
accepting the invitation.

Changing Team Roles
After the team member accepts the invitation, the team agent receives a confirmation email and the team
member has access to Member Center. Later, the team agent can change the role of a team member.

To change a team member’s role

1. In Member Center, click People at the top of the webpage.

2. Click All People in the sidebar.
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3. Click Details in the last column in the row of the person whose role you want to change.

4. Specify the person’s access and role for each program, and click Save.

Approving Development Certificates
If you’re a team admin for a company, it’s your responsibility to approve team member requests for development
certificates. Team members need a development certificate to sign apps, to use the team provisioning profile,
or to be added to other provisioning profiles. Team admins are notified via email when a team member requests
a development certificate. The email contains a link to Member Center to approve the request.

To learn how to request development certificates using Xcode, read “Requesting Signing Identities” (page 149).
Team admins also use Xcode to request their own signing certificates, which are automatically approved.
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Important:  All developers on a team should keep a secure backup of their private key. If the private key
is lost, that team member can no longer sign code without creating a new code signing identity. After
approving a development certificate, the team admin or agent should remind the team member to export
the member’s developer profile, as described in “Exporting Your Developer Profile” (page 160).

To approve a development certificate request

1. In Certificates, Identifiers & Profiles, select Certificates.

2. Under Certificates, select Pending.

3. Select the certificate.

4. Click Approve.

5. In the dialog, click Approve again.

If you use the team provisioning profile, regenerate it after approving the certificate. Xcode regenerates the
team provisioning profile whenever a team member refreshes provisioning profiles in Xcode, as described in
“Refreshing Provisioning Profiles in Xcode” (page 199). Afterward, all other team members should refresh their
provisioning profiles to download the latest team provisioning profile.
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Registering Team Member Devices
Before a team member can launch an app on his or her device, the device needs to be registered and added
to the team provisioning profile. Xcode automatically registers team agent and admin devices when needed,
as described in “Launching Your App on Devices” (page 84). However, a team agent or admin must register
team member devices on their behalf.

The team member sends the device name and device ID to their team admin. In Xcode, a team member can
select the device in the Devices organizer to display the device ID, as described in “Locating Device IDs Using
Xcode” (page 191). If you’re a Mac developer, you can also get the device ID using the System Information app,
as described in “Locating Mac Device IDs Using System Preferences” (page 193).

In Member Center, the team admin may register one device, as described in “Registering Individual
Devices” (page 193), or multiple devices, as described in “Registering Multiple Devices” (page 194).

Transferring the Team Agent Role
Because the team agent has sole legal responsibility for the team, another team member can’t demote the
team agent, nor can the team agent’s privileges be restricted. However, the team agent can transfer their role
to another team member using Member Center.
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To invite team members

1. In Member Center, sign in as the team agent and click Your Account at the top of the webpage.

2. In the Developer Account Summary section, click Transfer Agent Role next to your name.

3. Follow the instructions that appear in a series of dialogs.

For example, you will be asked to choose a new team agent and sign an Agent Transferor Agreement.

Recap
In this chapter, you learned how to perform some tasks on behalf of team members who don’t have privileges
to create development certificates or register their devices.

Managing Your Team
Recap

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

144

https://developer.apple.com/membercenter


Code signing your app lets users trust that your app has been created by a source known to Apple and that it
hasn’t been tampered with. All iOS apps and most Mac apps must be code signed and provisioned to launch
on a device, to be distributed for testing, or to be submitted to the store. Code signing uses cryptographic
technology to digitally sign your app and installer package. You create signing identities—stored in your
keychain—and certificates—stored in Member Center—to sign and provision your app. These assets uniquely
identify you or your team, so its important to keep them safe. This chapter covers common tasks that you
perform to protect and maintain your signing identities and certificates over the lifetime of your project.

For the types of the certificates you’ll use to develop, test, and distribute your app, refer to “Your Signing
Certificates in Depth” (page 179).

About Signing Identities and Certificates
Code signing your app allows the operating system to identify who signed your app and to verify that your
app hasn’t been modified since you signed it. Your app’s executable code is protected by its signature because
the signature becomes invalid if any of the executable code in the app bundle changes. Note that resources
such as images and nib files aren’t signed; therefore, a change to these files doesn’t invalidate the signature.

Code signing is used in combination with your App ID, provisioning profile, and entitlements to ensure that:

 ● Your app is built and signed by you or a trusted team member.

 ● Apps signed by you or your team run only on designated development devices.

 ● Apps run only on the test devices you specify.

 ● Your app isn’t using technologies you didn’t add to your app.

 ● Only you can submit revisions of your app to the store.

 ● If you choose to distribute outside of the store (Mac only), the app can’t be modified and distributed by
someone else.

Code signing also allows your app’s signature to be removed and re-signed by a trusted source. For example,
you sign your app before submitting it to the store, but Apple re-signs it before distributing it to customers.
Also, you can re-sign and submit a fully tested development build of your app to the store.
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Xcode uses your signing identity to sign your app during the build process. This signing identity consists of
a public-private key pair that Apple issues. The private key is stored in your keychain and used by cryptographic
functions to generate the signature. The certificate contains the public key and identifies you as the owner of
the key pair. The certificate is stored both in your keychain on your Mac and in your developer account. An
intermediate certificate is also required to be in your keychain to ensure that your certificate is issued by a
certificate authority.

To sign apps, you must have both the signing identity and the intermediate certificate installed in your keychain.
When you install Xcode, Apple’s intermediate certificates are added to your keychain for you. You use Xcode
to create your signing identity and sign your app. Your signing identity is added to your keychain and the
corresponding certificate is added to your account in Member Center.

Signing identities are used to sign your app or installer package. A development certificate identifies you, as
a team member, in a development provisioning profile that allows apps signed by you to launch on devices.
A distribution certificate identifies your team or organization in a distribution provisioning profile and allows
you to submit your app to the store. Only a team agent or an admin can create a distribution certificate. You
also use different development and distribution certificates to sign iOS and Mac apps. For a complete list of
certificate types, refer to “Your Signing Certificates in Depth” (page 179).

For a company, other team members have their own signing identities installed on their Macs. Member Center
contains a repository for all of the combined team assets but doesn’t store any of the private keys.

Because the private key is stored locally on your Mac, protect it as you would an account password. Keep a
secure backup of your public-private key pair. If the private key is lost, you’ll have to create an entirely new
identity to sign code. Worse, if someone else has your private key, they may be able to impersonate you. In
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the wrong hands, someone might attempt to distribute an app that contains malicious code. Not only could
that cause the app to be rejected, it could also mean your developer credentials could be revoked by Apple.
Private keys are stored only in the keychain and can’t be retrieved if lost.

If you want to code sign your app using another Mac, you export your developer profile on the Mac you used
to create your certificates and import it on the other Mac. You can also share distribution certificates among
multiple team agents using this feature.

Viewing Signing Identities and Provisioning Profiles
To verify or troubleshoot your certificates and profiles, view them in Xcode Accounts preferences. Although
Xcode manages these assets for you, you may occasionally need to request or revoke specific certificates and
to refresh your provisioning profiles.

To view account details

1. Choose Xcode > Preferences.

2. Click Accounts at the top of the window.
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3. Select the team you want to view, and click View Details.
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In the dialog that appears, view your signing identities and provisioning profiles.

4. Click Done to close the dialog.

Requesting Signing Identities
Before you can code sign your app, you create your development certificate and later, a distribution certificate
to submit your app to the store. You can create all the types of certificates and signing identities you need
using Xcode. Xcode requests, downloads, and installs your signing identities for you.

For a company, a team member requests their development certificate using Xcode, but downloads and installs
it later, after it’s approved, as described in “Approving Development Certificates” (page 141). Only a team agent
or admin can create a distribution certificate. Only a team agent can create a Developer ID certificate. If you
have a company membership, read “Managing Your Team” (page 136) for a description of team roles and tasks
that team agents perform on behalf of team members.
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Xcode asks to create development certificates for you when you need them. For example, when you assign
your project to a team or create the team provisioning profile, as described in “Configuring Identity and Team
Settings” (page 25), a dialog might appear asking if Xcode should create a certificate for you. Because of this,
you typically request distribution certificates using the Xcode Preferences window.

To request a signing identity

1. In the Xcode Preferences window, click Accounts.

2. Select the team you want to use, and click View Details.

3. In the dialog that appears, choose the type of certificate you want to create by clicking the Add button
(+) below the Signing Identities table.
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For a description of each type of certificate, refer to Table 11-2 (page 180).

4. In the Signing Identity Generated dialog that appears, click OK.

Maintaining Your Signing Identities and Certificates
Requesting Signing Identities

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

151



The new signing identity appears in the Signing Identities table.

A team member may need to wait until a team agent or admin approves the request.

5. To return to Accounts preferences, click Done.

You can now export your signing identities to create a backup, as described in “Exporting Your Developer
Profile” (page 160).

Verifying Your Steps
Verify that your certificates are correct and ready for use. Certificates must be valid in order to sign your
app—and for a Mac app, to sign your installer package.

The first time you verify your certificates, verify them in Xcode, Keychain Access, and Member Center to learn
where they’re located and how they appear in each tool. Keychain Access and Member Center display the
expiration dates of your signing identities and certificates. Later, you’ll use Keychain Access for troubleshooting.
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Note:  The name of the certificate in Keychain is different from the certificate type that appears in
Xcode and Member Center. For the mapping between the certificate names and types that appear
in the tools, refer to Table 11-2 (page 180).

Verifying Using Member Center
Member Center should show the same certificates you see in Xcode and Keychain Access because it stores the
public keys.

To verify signing certificates using Member Center

1. In Certificates, Identifiers & Profiles, select Certificates.

2. In the Certificates section, select Development or Production depending on the type of certificate you
want to verify.

The name, type, and expiration date of the certificate should match the information that you view in
Xcode.

Verifying Using Keychain Access
Keychain Access shows the private and public keys for each of your signing identities.

To verify signing identities using Keychain Access

1. Launch Keychain Access located in ~/Applications/Utilities.
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When you request a development or distribution certificate using Xcode, the certificate is automatically
installed in your login keychain.

2. In the left pane, select “login” in the Keychains section and select Certificates in the Category section.

Your development and distribution certificates appear in the Certificates category in Keychain Access.
The name of the development certificate begins with the text “iPhone Developer” for the iOS Developer
Program and “Mac Developer” for the Mac Developer Program, followed by your name (development
certificates belong to a person).

Other types of certificates also appear in the Certificates category of Keychain Access.

Tip:  Keep your personal keychain items in your login keychain. If your certificates don’t appear

in the login keychain, it may not be the default keychain. The default keychain appears in bold

in the Keychains column in Keychain Access. If the default keychain isn’t login, select login in

the Keychains column and choose File > Make Keychain “login” Default.

3. Verify that there’s a disclosure triangle to the left of the certificate.
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If you click the disclosure triangle next to the certificate name, your private key appears. If the disclosure
triangle doesn’t appear, you’re missing your private key. (Read “The Private Key for Your Signing Identity
Is Missing” (page 231) to fix this issue.)

4. Verify that the certificates are valid.

When you select a certificate, a green circle containing a checkmark appears in Keychain Access above
the list of certificates. The text next to the checkmark should read “This certificate is valid.”

Troubleshooting
If the certificates shown in Xcode and Keychain Access don’t match your certificates in Member Center, read
“Certificate Issues” (page 230) for information about how to resolve the discrepancies.

Requesting Additional Developer ID Certificates
Developer ID certificates are used to distribute your application outside of the Mac App Store. Create your
Developer ID certificates, along with other types of certificates, using Xcode, as described in “Requesting
Signing Identities” (page 149). If you want more Developer ID certificates, you can create up to five of each type
using Member Center.

To create a Developer ID certificate

1. In Certificates, Identifiers & Profiles, select Certificates.

2. Under Certificates, select All.

3. Click the Add button (+) in the upper-right corner.
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4. Select Developer ID under Production, and click Continue.

5. Select the certificate type—Developer ID Application or Developer ID Installer—and click Continue.

6. Follow the instructions to create a certificate signing request (CSR) using Keychain Access, and click
Continue.
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7. Click Choose File.

8. Select a CSR file (with a .certSigningRequest extension), and click Choose.

9. Click Generate.

10. Click Download.

The certificate file appears in your Downloads folder.

To install the Developer ID certificate in your keychain, double-click the downloaded certificate file (with a
.cer extension). The Developer ID certificate appears in the My Certificates category in Keychain Access.
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Installing Missing Intermediate Certificate Authorities
To use your certificates, you need to have the correct intermediate certificate in your keychain. An intermediate
certificate ensures that your certificates were issued by a trusted source. The intermediate certificate, named
Apple Worldwide Developer Relations Certification Authority, is installed in your system keychain when you
install Xcode. The intermediate certificate for Developer ID certificates is called Developer ID Certification
Authority. If you accidentally remove an intermediate certificate, you can install it again.

First try refreshing your provisioning profiles in Xcode, as described in “Refreshing Provisioning Profiles in
Xcode” (page 199), to install missing intermediate certificates. If that doesn’t work for you, download and install
the missing intermediate certificate.

To install a missing intermediate certificate

1. Go to http://www.apple.com/certificateauthority.

2. Click “Download certificate” under Apple Intermediate Certificates for the intermediate certificate you’re
missing.
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A certificate file, with a .cer extension, appears in your Downloads folder.

3. Double-click the certificate file to install it in your system keychain.

Exporting and Importing Certificates and Profiles
After Xcode creates your certificates and profiles for you, export them to create a backup of all your assets.
You do this to, for example, transfer your assets to another Mac you use for development or repair a certificate
if the private key is missing. Refreshing your certificates and profiles in Xcode won’t replace a missing private
key. Instead, import your certificates and profiles from a backup.

The export file, called a developer profile, contains the following team assets:

 ● Development certificates

 ● Distribution certificates
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 ● Provisioning profiles

You can also export selected certificates to share with other team members. In this case, the export file contains
just the certificates you select.

Exporting Your Developer Profile
Because the developer profile represents your credentials to sign and submit apps to the store, Xcode encrypts
and password-protects the exported file.

To export your developer account assets

1. Choose Xcode > Preferences.

2. Click Accounts at the top of the window.

3. Click the Action button (the gear icon to the right of the Delete button) in the lower-left corner.

4. Choose Export Accounts from the pop-up menu.

5. Enter a filename in the Save As field and password in both the Password and Verify fields.
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The file is encrypted and password protected.

6. Click Save.

The file is saved to the location you specified with a .developerprofile extension.

7. In the dialog that appears, click OK.

Exporting Selected Certificates
To export a few certificates and exclude the profiles, select the certificates in the details dialog.

To export selected certificates

1. Choose Xcode > Preferences.

2. Click Accounts at the top of the window.
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3. Select the team you want to view, and click View Details.

4. Select the certificates you want to export in the Signing Identities table.
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5. Choose Export from the pop-up menu below the Signing Identities table.

6. Enter a filename in the Save As field and password in both the Password and Verify fields.

The file is encrypted and password protected.

7. Click Save.

The file is saved to the location you specified with a .p12 extension.

8. Click Done.

Importing Your Developer Profile
You import your developer profile to restore missing private keys or when you want to switch to another Mac.

To import your developer account assets

1. Choose Xcode > Preferences.

2. Click Accounts at the top of the window.

3. Click the Action button (the gear icon) in the lower-left corner.
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4. Choose Import Accounts from the pop-up menu.

5. Locate and select the file containing your developer profile, and click Open.

The file should have a .developerprofile extension.

6. Enter the password you used to encrypt the file, and click OK.

7. In the dialog that appears, click OK.

Removing Signing Identities from Your Keychain
You remove signing identities from your keychain if they’re invalid, no longer used (perhaps they belong to a
previous team you were a member of ), or are missing the private key and consequently, aren’t usable. If you’re
missing a private key and have a backup of your signing identities, import your developer profile, as described
in “Importing Your Developer Profile” (page 163), immediately after removing the signing identities. If you
remove signing identities for some other reason, read all the steps in “Re-Creating Certificates and Updating
Related Provisioning Profiles” (page 170) to avoid code signing issues later.
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Warning:  You can’t re-create a private key once you remove it from your keychain unless you import

it from a developer profile file. If you’re intentionally re-creating your certificates, you must revoke all

of your certificates immediately after removing them from your keychain. If you don’t, Xcode downloads

and installs them in your keychain the next time you refresh your provisioning profiles. Without the

private keys, you can’t sign apps using the certificates.

To remove signing identities from your keychain

1. Launch Keychain Access (located in /Applications/Utilities).

2. In the Category section, select Keys.

3. Click the disclosure triangles for all the private keys to reveal the associated certificates.

4. Select all of the private keys associated with the certificates that you want to remove.

For how to recognize the type of certificate by the name as it appears in Keychain Access, refer to Table
11-2 (page 180).

5. Select the corresponding public key for each private key.

6. Press Delete (on the keyboard), and when a dialog appears, click Delete.

7. In the Category section, select Certificates.

8. Select all of the certificates that you want to remove.

The certificates won’t have private keys.

9. Press Delete (on the keyboard), and when a dialog appears, click Delete.
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Revoking Certificates
You revoke certificates when you no longer need them or when you want to re-create them because of another
code signing issue (refer to “Certificate Issues” (page 230) for the types of problems that can occur). You also
revoke certificates if you suspect that they have been compromised. If you’re a team admin for a company,
you may want to revoke development certificates of team members who no longer work on your project.
Revoking certificates may invalidate provisioning profiles, so read all the steps in “Re-Creating Certificates and
Updating Related Provisioning Profiles” (page 170) to avoid code signing issues later.

Revoking Privileges
Table 11-1 lists the types of certificates that each team member can revoke. Individual developers are the team
agent for their one-person team, which means they have permission to revoke all types of development and
distribution certificates except as indicated. For a company, any team member can revoke his or her own
development certificate, but a team member can only revoke distribution certificates if he or she is a team
agent or admin.

Table 11-1 Team certificate revoking privileges

Team memberTeam adminTeam agentType of certificate

Your development certificates:
iOS Development

Mac Development

Other team admin and member certificates:
iOS Development

Mac Development

The team agent’s certificate:
iOS Development

Mac Development

Store distribution certificates:
iOS Distribution

Mac App Distribution

Mac Installer Distribution
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Team memberTeam adminTeam agentType of certificate

Developer ID certificates:
Developer ID Application

Developer ID Installer

Push notification certificates:
APNs Development iOS

APNs Production iOS

APNs Development Mac

APNs Production Mac

Pass certificate:
Pass Type ID

You can’t revoke Developer ID or Passbook certificates using Member Center. Instead, send a request to Apple
at product-security@apple.com to revoke these types of certificates.

If Apple revokes your Developer ID certificate, users can no longer install applications that have been signed
with that certificate. Instead of revoking a Developer ID certificate, you can create additional Developer ID
certificates using Member Center as described in “Requesting Additional Developer ID Certificates” (page 155).

Revoking Development Certificates Using Xcode
If the development certificate you want to revoke appears in the Accounts preferences in Xcode—it’s a certificate
you created on your Mac and is in your keychain—then you can revoke it using Xcode. Otherwise, use Member
Center to revoke the certificate, as described in “Revoking Certificates Using Member Center.” (If you attempt
to revoke a distribution certificate using Xcode, you’ll be redirected to Member Center.)

To revoke a development certificate using Xcode

1. Choose Xcode > Preferences and click Accounts at the top of the window.
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2. Select your team and click View Details.
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3. In the dialog that appears, choose the development certificate you want to revoke and click the Action
button (the gear icon to the right of the Add button) below the Signing Identities table.

4. Choose Revoke from the pop-up menu.

5. In the dialog that appears, click Done.

Revoking Certificates Using Member Center
Use Member Center to revoke all types of certificates belonging to your team. For example, revoke development
certificates for other team members or distribution certificates that you no longer need or want to re-create.

To revoke a certificate using Member Center

1. In Certificates, Identifiers & Profiles, select Certificates.

2. Under Certificates, select All.
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3. Select the certificate you want to revoke, and click Revoke.

4. In the dialog that appears, click Revoke.

Replacing Expired Certificates
When your development or distribution certificate expires, remove it and request a new certificate in Xcode.
Follow the same steps to re-create certificates, as described in “Re-Creating Certificates and Updating Related
Provisioning Profiles” (page 170). Use Keychain Access or Member Center to view the expiration dates of your
signing identities and certificates, as described in “Verifying Using Member Center” (page 153) and “Verifying
Using Keychain Access” (page 153).

Re-Creating Certificates and Updating Related Provisioning Profiles
Re-creating certificates and updating related provisioning profiles isn’t a simple task, because these assets are
related and reside on both your Mac and in Member Center. If you revoke a certificate, any provisioning profile
that contains that certificate becomes invalid. Xcode automatically regenerates team provisioning profiles for
you, but you manage other types of provisioning profiles yourself. This section covers all the steps you perform
to fully restore your code signing assets.
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Note:  Xcode shows you the signing identities that are in your keychain, not all the certificates that
you may have in Member Center.

There are several reasons you might want to re-create your certificates and update related provisioning profiles.
For example, you do this if:

 ● You accidentally removed one or more private keys from your keychain and don’t have a backup to restore
from.

 ● You want to remove revoked or expired certificates and their related provisioning profiles.

 ● You want to remove all the certificates and provisioning profiles from a previous team before you join
another team.

 ● If you use multiple Macs for development or belong to multiple teams, you might want to set up your
Mac for a new project.

However, if you’re experiencing certificate, provisioning, or build issues, review “Certificate Issues” (page 230)
first before performing these steps because removing your certificates is irreversible.

Choose the certificates you want to re-create. For example, if you experience problems running your app on
a device, you may only need to re-create your development certificate. Keep in mind that re-creating a
distribution certificate doesn’t affect your development certificates or development provisioning profiles.
Similarly, re-creating a development certificate doesn’t affect your distribution certificate or distribution
provisioning profiles.

Important:  Re-creating your development or distribution certificates doesn’t affect apps that you’ve
submitted to the store nor does it affect your ability to update them.

Follow these steps to re-create your certificates and update related provisioning profiles:

1. Revoke the certificates using Member Center, as described in “Revoking Certificates” (page 166).
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Provisioning profiles containing a revoked certificate become invalid. For example, if you revoke your
development certificate, all the development provisioning profiles containing that certificate become
invalid:

2. If necessary, remove the signing identities for these certificates from your keychain, as described in
“Removing Signing Identities from Your Keychain” (page 164).

If you revoke your own development or distribution certificate, remove the corresponding signing identity
from your keychain. Otherwise, the owner of the certificate should remove the signing identity on his or
her Mac.

3. Optionally, request new certificates using Xcode, as described in “Requesting Signing Identities” (page
149).
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If you revoke a development certificate, requesting a new development certificate or refreshing provisioning
profiles in Xcode, as described in “Refreshing Provisioning Profiles in Xcode” (page 199), regenerates the
team provisioning profiles. They no longer appear invalid in Member Center after you do either of these
actions:

4. Remove or regenerate other types of provisioning profiles that contain the revoked certificates, as described
in “Editing Provisioning Profiles in Member Center” (page 201).

Xcode doesn’t automatically regenerate distribution provisioning profiles or custom development
provisioning profiles you create using Member Center.

5. If you changed provisioning profiles in Member Center, refresh your provisioning profiles in Xcode, as
described in “Refreshing Provisioning Profiles in Xcode” (page 199).

6. If necessary, install the modified provisioning profiles on your devices, as described in “Removing
Provisioning Profiles from Devices” (page 204).

7. Once the certificates are repaired on the primary Mac, export your developer profile, as described in
“Exporting Your Developer Profile” (page 160).

If you’re repairing multiple Macs, perform these additional steps on the other Macs:

1. Remove the signing identities from your keychain, as described in “Removing Signing Identities from Your
Keychain” (page 164).

2. Import your developer profile, as described in “Importing Your Developer Profile” (page 163), that you
created on the original Mac.
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Creating Push Notification Client SSL Certificates
You use Member Center to generate your push notification client SSL certificates. A client SSL certificate allows
your notification server to connect to the APNs. Each App ID is required to have its own client SSL certificate.
Similar to signing certificates, you use separate client SSL certificates for development and distribution.

If you don’t have an explicit App ID that matches the bundle ID, create an explicit App ID, as described in
“Registering App IDs” (page 181), before continuing. Otherwise, creating a push notification SSL certificate
automatically enables the explicit App ID to use push notifications. Review all the steps in “Configuring Push
Notifications” (page 65) to add this capability to your app.

To generate client SSL certificates

1. In Certificates, Identifiers & Profiles, select Certificates.

2. Click the Add button (+) in the upper-right corner.
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3. Select the checkbox next to “Apple Push Notification service SSL” either under Development or
Production, and click Continue.

4. Choose an App ID from the App ID pop-up menu, and click Continue.

5. Follow the instructions on the next webpage to create a certificate request on your Mac, and click
Continue.

6. Click Choose File.

7. In the dialog that appears, select the certificate request file (with a .certSigningRequest extension),
and click Choose.
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8. Click Generate.

9. Optionally, click Download.

10. Click Done.

Setting the Code Signing Identity Build Setting
Occasionally, you may want to use your own custom development provisioning profile instead of the team
provisioning profile that Xcode manages for you. For example, you might do this if you want to limit
development of an app to a subset of developers or if you’re testing different app configurations. If so, create
a development provisioning profile, as described in “Creating Provisioning Profiles Using Member Center” (page
198), and set your code signing identity build setting to use the new profile.

When you build the app, you code sign it with the signing identity matching the certificate contained in the
provisioning profile you want to use. The possible values for the Code Signing Identity build setting pop-up
menu are:
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 ● Don’t Code Sign. Don’t sign your app. Choosing this option disables entitlements including sandboxing.

 ● Automatic Profile Selector. Selects an identity that matches your developer or distribution certificate
name.

 ● Identities without Provisioning Profiles. Selects a code signing identity that isn’t in a provisioning profile.

 ● Other. Selects a specific code signing identity. The code signing identities in your default keychain are
listed by the name. Expired or otherwise invalid identities are dimmed and can’t be chosen.

A menu item appears in the Code Signing Identity build setting pop-up menu for each provisioning profile to
which your development certificate belongs. The default setting is the platform-specific development certificate
that appears in the Automatic Profile Selector menu item, which matches your development certificate. For a
description of each type of certificate that may appear in this menu, refer to Table 11-2 (page 180).

Before you begin, decide whether to set the Code Signing Identity build setting at the project or target level.
For a single target, you can set this build setting at either the project or target level as long as you’re consistent.
For multiple targets that use the same code signing identity, set this build setting at the project level. For
multiple targets that use different code signing identities, you set this build setting for each individual target.
For example, choosing the project level ensures that any helper apps inside of your project are code signed
as well as the main app.

Set the Provisioning Profile build setting to your development profile and the Code Signing Identity build
setting to your development certificate.

To set the code signing identity to your development certificate

1. In the Xcode project editor, select the target.

Important:  If you want to sign multiple targets with the same code signing identity, select the
project, not a target.

2. Click Build Settings.

3. In the Build Settings pane, click All and type Code Signing in the search field.

4. From the Provisioning Profile pop-up menu, choose your development provisioning profile.

Xcode automatically sets the Code Signing Identity build setting to “iPhone Developer” for iOS apps
and “Mac Developer” for Mac apps.

5. If necessary, from the Code Signing Identity pop-up menu, choose your development certificate.
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For iOS apps, choose the certificate in the provisioning profile menu item that begins with the text
“iPhone Developer:” followed by your name. For Mac apps, choose the certificate in the provisioning
profile menu item that begins with the text “Mac Developer:” followed by your name.

Your app is code signed the next time you build it. You can build and run your Mac app by simply clicking the
Run button. For an iOS app, follow the steps in “Launching Your iOS App on a Device” (page 84) to sign your
app and launch it on a device.

To use the team provisioning profile again later, change the Provisioning Profile build setting to None. To learn
more about Apple’s code signing technology, read Code Signing Guide .

Troubleshooting
If the development provisioning profile doesn’t appear in the Provisioning Profile menu, refresh provisioning
profiles, as described in “Refreshing Provisioning Profiles in Xcode” (page 199). Then try to set the Provisioning
Profile and Code Signing Identity build settings again.

If a code signing error occurs when you build the app, verify that the Code Signing Identity build setting is
correct. Also, check whether the Code Signing Identity build setting is set at the project or target level (target
settings override project settings). To troubleshoot the Code Signing Identity build setting, read “Build and
Code Signing Issues” (page 234).
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Your Signing Certificates in Depth
Your code signing identities, stored in your keychain, represent your iOS and Mac program development and
distribution credentials. You should be familiar with the names of these certificates, because they appear in
menus, and the types of certificates, because they appear in lists, so that you don’t accidentally remove them
from your keychain or Member Center.

There are different types of signing certificates for different purposes. Development certificates identify a
person on your team and are used to run an app on a device. During development and testing, you’re required
to sign all iOS apps that run on devices and Mac apps that use certain technologies like iCloud and Game
Center.

Distribution certificates identify the team and are used to submit your app to the store or for a Mac app,
distribute it outside of the store. If you’re a company, distribution certificates can be shared by team members
who have permission to submit your app. There are multiple kinds of distribution certificates, each associated
with a specific method of distribution. Different code signing identities are also used for iOS and Mac apps.

Signing certificates are issued and authorized by Apple. You must have the intermediate certificate provided
by Apple installed in your system keychain to use your certificate; otherwise, it’s invalid. The intermediate
certificates provided by Apple and installed by Xcode are:

 ● Apple Worldwide Developer Relations Certification Authority. Used to validate development and store
certificates.

 ● Developer ID Certification Authority. Used to validate a Developer ID certificate for distribution outside
of the Mac App Store.

Refer to Table 11-2 for the mapping between the type of the certificate, the name of the certificate as it appears
in Keychain Access, and the purpose of each.

Member Center displays the team name (or person’s name) and type for each certificate. Xcode Accounts
preferences displays the type of certificate in the Signing Identities column. Keychain Access and the Code
Signing Identity build setting pop-up menu in Xcode display the name of the certificate.

There’s one Mac or iOS development certificate per team member. Therefore, development certificate names
contain the person’s name. All other types of certificates are owned by the team (shared by multiple team
members) and so, contain the team name. Individual developers are a one-person team, and so your name
and the team name are the same.
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Table 11-2 Certificate types and names

DescriptionCertificate nameCertificate type

Used to run an iOS app on devices and use
certain technologies and services during
development.

iPhone Developer: Team
Member Name

iOS Development

Used to distribute your iOS app on designated
devices for testing or to submit it to the App
Store.

iPhone Distribution: Team
Name

iOS Distribution

Used to enable certain technologies and
services during development and testing.

Mac Developer: Team
Member Name

Mac Development

Used to sign a Mac app before submitting it
to the Mac App Store.

3rd Party Mac Developer
Application: Team Name

Mac App
Distribution

Used to sign and submit a Mac Installer
Package, containing your signed app, to the
Mac App Store.

3rd Party Mac Developer
Installer: Team Name

Mac Installer
Distribution

Used to sign a Mac app before distributing it
outside the Mac App Store.

Developer ID Application:
Team Name

Developer ID
Application

Used to sign and distribute a Mac Installer
Package, containing your signed app, outside
the Mac App Store.

Developer ID Installer: Team
Name

Developer ID
Installer

Recap
In this chapter, you learned how to maintain your development and distribution signing identities that you’ll
use throughout the lifetime of your app. You also learned how to identify the different types of certificates in
Xcode, Keychain Access, and Member Center.
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You use Member Center to manage the identifiers, devices, and profiles used to code sign your app, enable it
to launch on devices, and use certain technologies and services. Xcode creates and manages these assets for
you during development. When you’re ready to distribute your app for testing, you use Member Center to
manage some of these assets yourself. For example, you use Member Center to create your ad hoc and store
provisioning profiles. Also, you might want to upload a list of devices used for testing, not register them
individually. This chapter covers miscellaneous tasks you perform to maintain identifiers, devices, and profiles.

For how to use Website Push IDs, read Notification Programming Guide for Websites .

Registering App IDs
You can create a wildcard App ID that matches one or more apps or an explicit App ID that exactly matches
your bundle ID. The technologies enabled for an App ID serve as a white list of the technologies one or more
apps may use. What technologies an app actually uses is configured in the Xcode project. You can enable
technologies when you create an App ID or modify these settings later. Game Center and In-App Purchase are
enabled by default for an explicit iOS App ID. In-App Purchase is enabled by default for an explicit Mac App
ID.

In most cases, the wildcard and explicit App ID that Xcode creates for you when you add capabilities to your
app, as described in “Adding Capabilities” (page 54), are sufficient to develop, test, and distribute your app.
There can be only one explicit App ID per app, so if one already exists, Xcode uses it to create team provisioning
profiles on your behalf.

To register an App ID

1. In Member Center, select Certificates, Identifiers & Profiles.

2. Under Identifiers, select App IDs.
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3. Click the Add button (+) in the upper-right corner.

4. Enter a name or description for the App ID in the Name field.

Maintaining Identifiers, Devices, and Profiles
Registering App IDs

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

182



5. To create an explicit App ID, select Explicit App ID and enter the app’s bundle ID in the Bundle ID field.

An explicit App ID exactly matches the bundle ID of an app you’re building—for example,
com.example.gitakumar.adventure. An explicit App ID can’t contain an asterisk (*).

If you entered a bundle ID in the target’s Summary pane in Xcode, the App ID you enter here should
match your bundle ID.

6. To create a wildcard App ID, select Wildcard App ID and enter a bundle ID suffix in the Bundle ID field.
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7. Select the corresponding checkboxes to enable the technologies you want to use, and click Continue.

A checkbox is disabled if the technology requires an explicit App ID and you’re creating a wildcard App
ID, or the technology is enabled by default.

8. Review the registration information, and click Submit.

9. Click Done.

Editing App IDs
For technologies you can’t enable using Xcode, you can edit an App ID directly using Member Center. To enable
technologies for one or more apps, edit the corresponding App ID in Member Center.

To enable technologies for an existing App ID

1. In Member Center, select Certificates, Identifiers & Profiles.

2. Under Identifiers, select App IDs.

3. Select the App ID you want to change, and click Edit.
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4. Select the corresponding checkboxes to enable the technologies you want to allow.

5. If a warning dialog appears, click OK.

Later, you’ll regenerate the provisioning profiles that use the App ID.

6. Click Done.

To fully enable push notifications, read “Configuring Push Notifications” (page 65).

Deleting App IDs
You can also remove App IDs when you no longer need them.

To remove an App ID

1. In Member Center, select Certificates, Identifiers & Profiles.
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2. Under Identifiers, select App IDs.

3. Select the App ID you want to delete and then click Edit.

4. Scroll to the bottom of the page and click Delete.

5. Read the dialog that appears and click Delete.

Provisioning profiles that contain a deleted App ID become invalid. You can change the App ID in the
provisioning profiles, as described in “Editing Provisioning Profiles in Member Center” (page 201), or delete
them.

Locating Your Team ID
Occasionally, you may need to know your Team ID. For example, if you want to receive an app from another
developer, the developer needs your Team ID to initiate the app transfer in iTunes Connect. The Team ID is a
unique 10-character string generated by Apple that’s assigned to your team. You can find your Team ID using
Member Center.
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To locate your Team ID

 ● In Member Center, select Your Account.

Your Team ID appears in the Developer Account Summary section under the team name.
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Registering Devices Using Xcode
Xcode needs one or more devices registered with the Member Center to create the team provisioning profile
and for you to run an app on a device. Xcode automatically registers your Mac or a connected iOS device that’s
enabled for development and chosen from the destination Scheme pop-up menu in the project editor. However,
if an iOS device isn’t enabled for development, it doesn’t appear in this menu. In this case, use the Devices
organizer to enable it. You can register it with Member Center using the Devices organizer, too.

You can register development devices using either Xcode or Member Center. Use Xcode to register individual
devices that you have access to, and later use Member Center to register multiple devices for beta testing, as
described in “Registering Devices Using Member Center” (page 190).

To provision your device for development

1. To display the Devices organizer in Xcode, choose Window > Organizer, and click Devices.

2. For an iOS app, connect your device to your Mac.

3. In the Devices section, select your device.

4. Click the “Use for Development” or “Add to Member Center” button.
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If the device was previously used for development, the “Use for Development” button doesn’t appear.
If this happens, click “Add to Member Center” at the bottom of the window instead.
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5. Select the checkbox next to your account name, and click Choose.

6. If a Certificate Not Found dialog appears, click Request.

Xcode offers to request your development certificate depending on whether your app is for iOS or
Mac. If you’re an individual developer, wait while Xcode submits the request. iOS developers need an
iOS Development certificate, and Mac developers need a Mac Development certificate to proceed.

If needed, Xcode creates your team provisioning profile.

Registering Devices Using Member Center
In Member Center, you can register devices individually as needed or upload a file with information on multiple
devices. Each year, you’re allowed to register a fixed number of devices. The maximum number of devices you
can register is 100 per membership year. If you later disable a device, as described in “Disabling and Enabling
Devices Using Member Center” (page 197), it doesn’t decrease your count of registered devices.
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Locating Device IDs
You need the name and device ID for each device you want to register. There are several ways to obtain device
IDs depending on whether you have Xcode installed.

Locating Device IDs Using Xcode
In Xcode, a team member can select a device in the Devices organizer to display the device ID.

To locate your device ID using Xcode

1. Choose Window > Organizer.

2. In the Devices organizer under Devices, select your device (your Mac is a device too).

3. Select and copy the text in the Identifier field.
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Locating iOS Device IDs Using iTunes
For iOS devices, you can also obtain a device ID using iTunes. For example, testers follow these steps to get
their device ID using iTunes when they don’t have Xcode installed.

To get a device ID using iTunes

1. Launch iTunes on your Mac.

2. Connect your device to your Mac.

3. In the upper-right corner, select the device.

4. In the Summary pane, click the Serial Number label under Capacity or Phone Number.

The label Serial Number changes to Identifier and displays the device ID.

5. Copy the device ID by Control-clicking the identifier and choosing Copy Identifier (UDID).

If the menu contains a Copy Serial Number menu item, repeat steps 4 and 5 again.

6. Paste the device ID in a document or an email message.
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Locating Mac Device IDs Using System Preferences
For Mac apps, you can get a device ID using the System Information app. For example, use this method if you
want to register a Mac for testing that isn’t used for development.

To locate your Mac device ID using System Information

1. Open the System Information app located in the /Applications/Utilities folder.

2. Select Hardware in the left column.

The device ID, or hardware UUID, appears near the bottom of the Hardware Overview pane and is in the
format XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX.

Registering Individual Devices
To register a device using Member Center, you need to have the device name and device ID.

To register a single device

1. In Certificates, Identifiers & Profiles, select Devices.

2. Under Devices, select All.

3. Click the Add button (+) in the upper-right corner.

4. Select Register Device.
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5. Enter a device name and the device ID (UDID).

6. Scroll to the bottom of the page, and click Continue.

7. Review the registration information, and click Submit.

Registering Multiple Devices
If you have many test devices, you can create a file containing the device names and device IDs and upload
the entire file to Member Center. Member Center supports these two file formats: a property list file with a
.deviceids file extension and a plain text file. The file format you choose depends on whether you have
access to the devices you want to register.

Creating a Property List Devices File
If you have access to the testing devices, you can use iPhone Configuration Utility to create a property list file
that contains the device names and device IDs of the devices you connect to your Mac.
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To download iPhone Configuration Utility

1. Go to http://www.apple.com/support/iphone/enterprise/.

2. Scroll down to the iPhone Configuration Utility section.

3. Click the appropriate download link and follow the online instructions.

To create the devices file using iPhone Configuration Utility

1. Launch iPhone Configuration Utility.

2. Connect each device to your Mac in turn.

iPhone Configuration Utility adds the device information to the Devices section under Library.

3. Select Devices under Library and select the devices you want to add to the file.

4. Click Export in the toolbar.

5. Enter a filename in the Save As field.

6. Choose Device UDIDs from the “Export type” pop-up menu.

7. Click Save.

Creating a Plain Text Devices File
If you don’t have access to the testing devices, you can create a .txt file containing the device names and
device IDs you collect using another method. In this case, create a tab-delimited file with one device ID and
one device name in each row. You can use the first row for your headers, because that row is ignored when
parsed.

Uploading the Devices File
In Member Center, the steps to upload the devices file are the same for both file formats.

To register multiple devices

1. In Certificates, Identifiers & Profiles, select Devices.

2. Under Devices, select All.

3. Click the Add button (+) in the upper-right corner.

4. Select Register Multiple Devices.
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5. Click Choose File.

6. Select the file you want to upload, and click Choose.

Select either the .deviceids or .txt file you created earlier.

7. Click Continue.

8. Review the registration information, and click Submit.

Installing iOS Developer Previews on Your Device
Before you begin, download the iOS developer preview you want to install on your device from iOS Dev Center.

To install an iOS developer preview on your development device

1. Connect your device to your Mac.

2. In the Devices organizer under Devices, select your device and under Software Version, click “Restore
using iTunes.”

3. In iTunes, Option-click the Restore iPhone/iPad/iPod button in the Summary pane.

4. Select the iOS beta software restore image and click Open to begin installation.

5. When installation is complete, activate the device and restore its contents using iTunes.

6. Back in Xcode, click “Use for Development” in the Devices organizer to reenable the device for
development.
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Disabling and Enabling Devices Using Member Center
You can disable and enable a device, but you can’t delete it from Member Center. You can disable a device
you no longer use for development or testing. However, doing so invalidates provisioning profiles that contain
the device and doesn’t increase your total count of devices for the year. You can also enable a device that you
previously disabled.

To disable or enable a device

1. In Certificates, Identifiers & Profiles, select Devices.

2. Under Devices, select All.

3. Select the device you want to disable or enable.

4. Click either Enable or Disable.

5. In the dialog that appears, click either Enable or Disable again.

To regenerate invalid team provisioning profiles after disabling a device, read “Refreshing Provisioning Profiles
in Xcode” (page 199). To remove a disabled device from other provisioning profiles you manage, read “Editing
Provisioning Profiles in Member Center” (page 201).

You can also enable a device using Xcode. For iOS apps, Xcode automatically registers a connected device
that’s enabled for development and chosen from the destination Scheme pop-up menu in the project editor.
For Mac apps, Xcode automatically registers the Mac that’s running Xcode. If the device or Mac was previously
registered but is disabled, Xcode enables it.

Maintaining Identifiers, Devices, and Profiles
Disabling and Enabling Devices Using Member Center

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

197

http://developer.apple.com/account


You may still run your app on a disabled device if it is in an older version of a provisioning profile that is installed
on the device. To remove old versions of your provisioning profiles, read “Removing Provisioning Profiles from
Devices” (page 204).

Creating Provisioning Profiles Using Member Center
You can create both development and distribution provisioning profiles yourself using Member Center. To
create an ad hoc provisioning profile for testing an iOS app, read “Creating Ad Hoc Provisioning Profiles” (page
93). To create a store provisioning profile, read “Creating Store Provisioning Profiles” (page 111). Because Xcode
creates and manages team provisioning profiles for you, you only create a development provisioning profile
if you want to restrict development of an app to specific team members and devices. Follow the steps in this
section if you want to create your own development provisioning profile.

Before creating a development provisioning profile, verify that you have an App ID, one or more development
certificates, and one or more devices. If you want to register your own App ID, read “Registering App IDs” (page
181). (You can also use one of the App IDs that Xcode manages for you.) If you need to create your development
certificate, read “Requesting Signing Identities” (page 149). If you need to register devices, read “Registering
Devices Using Xcode” (page 188) or “Registering Devices Using Member Center” (page 190).

To create a development provisioning profile

1. In Certificates, Identifiers & Profiles, select Provisioning Profiles.

2. Click the Add button (+) in the upper-right corner.
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3. Select iOS App Development for iOS apps or Mac App Development for Mac apps as the distribution
method, and click Continue.

4. Select the App ID you want to use for development, and click Continue.

5. Select one or more development certificates, and click Continue.

6. Select one or more devices, and click Continue.

7. Enter a profile name, and click Generate.

8. Click Done.

After creating your provisioning profile, refresh provisioning profiles in Xcode, as described in “Refreshing
Provisioning Profiles in Xcode” (page 199).

Refreshing Provisioning Profiles in Xcode
Changes you make in Member Center aren’t automatically reflected in Xcode. For example, if you create or
edit a provisioning profile in Member Center, refresh provisioning profiles in Xcode to download the changes.
If you revoke a development certificate, refresh provisioning profiles to regenerate team provisioning profiles
managed by Xcode. When Xcode refreshes provisioning profiles, it also checks to see if you’re missing signing
identities and may ask if you want to request them.

To refresh provisioning profiles in Xcode

1. In the Xcode Preferences window, click Accounts.

Maintaining Identifiers, Devices, and Profiles
Refreshing Provisioning Profiles in Xcode

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

199



2. Select your team, and click View Details.

3. In the dialog that appears, click the Refresh button in the lower-left corner under the Provisioning
Profiles table.
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Xcode updates the list of profiles in the Provisioning Profiles table.

Editing Provisioning Profiles in Member Center
You don’t need to re-create provisioning profiles to edit them. You can change the name of a provisioning
profile and other properties depending on the type of provisioning profile. For all types of provisioning profiles,
you can change the App ID. For an iOS app, you can add devices to an ad hoc provisioning profile. If you change
a provisioning profile, remember to replace instances of the provisioning profile that you installed on devices.

If you want to repair a provisioning profile because you re-created a certificate, follow the steps in “Re-Creating
Certificates and Updating Related Provisioning Profiles” (page 170).

Note:  You can’t modify the team provisioning profile managed by Xcode.

To edit a provisioning profile

1. In Certificates, Identifiers & Profiles, select Provisioning Profiles.
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2. Under Provisioning Profiles, select All.

3. Select the provisioning profile you want to modify, and click Edit.
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4. Make your changes to the provisioning profile, such as changing its name, adding certificates, or
selecting a different set of devices.

5. Click Generate.

After the profile is generated, you can download the profile or refresh provisioning profiles in Xcode.
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Renewing Expired Provisioning Profiles
If a provisioning profile expires, the provisioning profile’s status displays Expired in Member Center. You renew
an expired provisioning profile by editing and re-generating it, as described in “Editing Provisioning Profiles
in Member Center” (page 201). You don’t need to make any changes to the provisioning profile. Just scroll to
the bottom of the “Edit iOS Provisioning Profile” or “Edit Mac Provisioning Profile” page and click Generate.

If the expired provisioning profile is installed on your device, remove it, as described in “Removing Provisioning
Profiles from Devices” (page 204). If the provisioning profile is an ad hoc provisioning profile, then re-sign and
distribute your app using the regenerated provisioning profile, as described in “Beta Testing Your iOS App” (page
91).

Removing Provisioning Profiles from Devices
You remove expired or invalid provisioning profiles from devices as needed. Use Xcode to remove provisioning
profiles from iOS devices and if necessary, System Preferences to remove them from Macs.
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Note:  You rarely install a provisioning profile yourself because when you launch an app on a device,
iOS and OS X automatically install the embedded provisioning profile in the app’s bundle on the
device.

To remove a provisioning profile from an iOS device using Xcode

1. Connect your iOS device to your Mac.

2. To display the Devices organizer in Xcode, choose Window > Organizer, and click Devices.

3. Select the disclosure triangle next to your device under Devices to reveal the contents.

4. Select Provisioning Profiles in the left column under your device.

5. Select the provisioning profile you want to delete on the right.

6. Click Delete.

7. In the dialog that appears, click Delete.
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On OS X, provisioning profiles that are embedded in app bundles do not appear in System Preferences. However,
if you download a provisioning profile from Member Center and double-click it to install it yourself, it will
appear in System Preferences. To remove profiles from a Mac, open System Preferences, select Profiles under
System, select the profile, and click the Delete button (–) in the lower-left corner.

Removing Provisioning Profiles from Member Center
Occasionally, you may need to remove a provisioning profile from your team.

To remove a provisioning profile from your team

1. In Certificates, Identifiers & Profiles, select Provisioning Profiles.

2. Under Provisioning Profiles, select All.

3. Select the provisioning profile you want to remove.
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4. Click Delete.

5. In the dialog that appears, click Delete.

After doing so, refresh provisioning profiles, as described in “Refreshing Provisioning Profiles in Xcode” (page
199), and remove the provisioning profile from your devices, as described in “Removing Provisioning Profiles
from Devices” (page 204).

Downloading Provisioning Profiles from Member Center
If necessary, you can download specific provisioning profiles directly from Member Center.

To download a provisioning profile

1. In Certificates, Identifiers & Profiles, select Provisioning Profiles.

2. Under Provisioning Profiles, select All.

3. Select the ad hoc provisioning profile.
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4. Click Download.

A file with the provisioning profile name and the .mobileprovision extension appears in your
Downloads folder.

Verifying That Your Team Provisioning Profile Is Installed on Your
Device
Occasionally, your app may not launch on a device because the provisioning profile installed on the device is
incorrect. Use Xcode to examine the provisioning profiles on your iOS device.

To verify that a provisioning profile is installed on your iOS device

1. Connect your iOS device to your Mac.

2. To display the Devices organizer in Xcode, choose Window > Organizer, and click Devices.

3. Click the disclosure triangle next to your device under Devices.

4. Select Provisioning Profiles under your device.
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Your provisioning profile should be listed in the detail area with the status “Valid profile.”

On OS X, provisioning profiles that are embedded in app bundles do not appear in System Preferences. However,
if you download a provisioning profile from Member Center and double-click it to install it yourself, it will
appear in System Preferences.

To verify that your provisioning profile is installed on your Mac using System Preferences

1. Launch System Preferences.

2. Select Profiles under System.

If you have one or more profiles installed, a Profiles icon appears; otherwise, it doesn’t.

3. Select a provisioning profile under Provisioning Profiles.
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Verify that your provisioning profile is valid. The provisioning profile is valid if it hasn’t expired and the
text “Verified” appears under the name of the provisioning profile.

Verifying the App Binary Entitlements
Some entitlements (for example, App Sandbox entitlements) are set in your Xcode project and others are set
in the provisioning profile. You can check if the signed app has the correct entitlements by examining the
app’s signature and if discrepancies occur, by examining the embedded provisioning profile located in the
app binary.

To verify the entitlements of a signed app

1. In Xcode, select your project in the project navigator.

2. Click the disclosure triangle next to the project to reveal its contents.

3. Click the disclosure triangle next to Products to reveal the binary.
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4. Control-click the binary and select “Show in Finder” to go to the Xcode build location in the Finder.

5. Launch Terminal (located in ~/Applications/Utilities) and enter this text followed by a space
character (do not press Return):

codesign -d --entitlements -

6. In the Finder, drag the app binary to Terminal.

7. Press Return.

For example, the output for an iOS app that is enabled for iCloud key-value storage contains the
com.apple.developer.ubiquity-kvstore-identifier entitlement key. The output for a Mac
app that is enabled for App Sandbox contains the com.apple.security.app-sandbox entitlement
key.

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN"
"http://www.apple.com/DTDs/PropertyList-1.0.dtd">

<plist version="1.0">

<dict>

<key>application-identifier</key>
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<string>G9B5P7QDV2.edu.self.HelloWorld</string>

<key>com.apple.developer.pass-type-identifiers</key>

<array>

<string>G9B5P7QDV2.*</string>

</array>

<key>com.apple.developer.ubiquity-container-identifiers</key>

<array>

<string>G9B5P7QDV2.edu.self.HelloWorld</string>

</array>

<key>com.apple.developer.ubiquity-kvstore-identifier</key>

<string>G9B5P7QDV2.edu.self.HelloWorld</string>

<key>get-task-allow</key>

<true/>

</dict>

</plist>

If the app’s entitlements are different than what you have configured, verify that the embedded provisioning
profile is correct. First, you need to locate the embedded provisioning profile.

To locate the embedded provisioning profile in the app binary

1. In Xcode, select your project in the project navigator.

2. Click the disclosure triangle next to the project to reveal the contents.

3. Click the disclosure triangle next to Products to reveal the binary.
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4. Control-click the binary and select “Show in Finder” to go to the Xcode build location in the Finder.

5. In the Finder, Control-click the binary and select Show Package Contents from the menu.
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For iOS apps, a provisioning profile called embedded.mobileprovision appears in the Finder window.
For Mac apps, the embedded file is called embedded.provisionprofile.

To verify the entitlements of the embedded provisioning profile

1. Launch Terminal (located in ~/Applications/Utilities) and enter this text (do not press Return):

security cms -D -i
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2. In the Finder, drag the provisioning profile in the app binary to Terminal.

3. Press Return.

This command outputs a property list in XML format.

4. Locate the Entitlements key in the output and verify that the application-identifier key has
the correct entitlements.

For example, the following listing shows an iOS app that is enabled for data protection, Passbook, and
iCloud. iCloud entitlements begin with the text com.apple.developer.ubiquity.

<key>Entitlements</key>

<dict>

<key>application-identifier</key>

<string>G9B5P7QDV2.*</string>

<key>com.apple.developer.default-data-protection</key>

<string>NSFileProtectionComplete</string>

<key>com.apple.developer.pass-type-identifiers</key>

<array>

<string>G9B5P7QDV2.*</string>

</array>

<key>com.apple.developer.ubiquity-container-identifiers</key>

<array>

<string>G9B5P7QDV2.*</string>

</array>
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<key>com.apple.developer.ubiquity-kvstore-identifier</key>

<string>G9B5P7QDV2.*</string>

<key>get-task-allow</key>

<true/>

<key>inter-app-audio</key>

<true/>

<key>keychain-access-groups</key>

<array>

<string>G9B5P7QDV2.*</string>

</array>

</dict>

See codesign and security for more ways to use these commands.

Recap
In this chapter, you learned how to maintain your certificates and provisioning profiles in a valid state and
remove assets that you no longer need. To resolve specific certificate and provisioning profile issues, read
“Troubleshooting” (page 230).
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In some cases, you may want to distribute an application outside the Mac App Store. Because that application
won’t be distributed through the Mac App Store, use a Developer ID certificate to give your users assurance
that you’re an Apple-identified developer.

Mac users have the option of turning on Gatekeeper, a security feature that gives users the ability to install
software only from the Mac App Store and identified developers. If your application isn’t signed with a Developer
ID certificate issued by Apple, it won’t launch on a Mac that has Gatekeeper enabled. To avoid this situation,
sign your applications and installer packages using a Developer ID certificate. Also, thoroughly test the end-user
experience using a Gatekeeper-enabled Mac before distributing your application outside of the Mac App Store.

This chapter describes the Xcode steps to create and test Developer ID-signed applications for distribution
outside of the Mac App Store.

Creating Developer ID-Signed Applications or Installer Packages
Creating a Developer ID-signed application or installer package is a multistep process. First you tell Xcode that
you intend to distribute your application outside of the Mac App Store and then request Developer ID certificates.
There are two types of Developer ID certificates: a Developer ID Application is used to sign applications, and
a Developer ID Installer is used to sign installer packages. Using Xcode, you export and sign an archive of your
application using the Developer ID Application certificate. You can also use command-line utilities to sign an
installer package using the Developer ID Installer certificate.

Important:  Before you begin, enroll in the Mac Developer Program, as described in “Adding a Developer
Program to Your Team” (page 20). Only Mac Developer Program members are eligible to request Developer
ID certificates and sign applications or installer packages using them.

Setting the Code Signing Identity to Developer ID
First set the code signing identity in the General pane to Developer ID.

To set the signing identity to Developer ID

1. In the project navigator, select the target to display the project editor.
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2. Click General and, if necessary, click the disclosure triangle next to Identity to reveal the settings.

3. Verify that your bundle ID is unique.

4. Under Signing, select Developer ID as the signing identity.

5. If necessary, choose your team or “Add an Account” from the Team pop-up menu.

A warning message and Fix Issue button may appear below the Team pop-up menu. You don’t use a
team provisioning profile when signing your app with a Developer ID certificate so can ignore this
message.

You can’t use key technologies and services if you distribute outside of the Mac App Store. If you enable a
capability in the Capabilities pane, as described in “Adding Capabilities” (page 54), the Signing radio button
reverts to Mac App Store.

Requesting Developer ID Certificates
You use signing certificates that begin with the text “Developer ID” to distribute your application outside the
Mac App Store.
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When you refresh provisioning profiles for the first time, as described in “Refreshing Provisioning Profiles in
Xcode” (page 199), Xcode asks whether to request all types of certificates on your behalf. Be sure to select the
Developer ID certificates from the Certificates Not Found dialog and click Request.

Otherwise, use Accounts preferences to specifically request any missing Developer ID certificates, described
in “Requesting Signing Identities” (page 149).

To use these certificates, you also need the Developer ID Certification Authority intermediate certificate that
Xcode installs in your keychain for you, to use these certificates. If you’re missing this intermediate certificate,
read “Installing Missing Intermediate Certificate Authorities” (page 158) to restore it.

You should immediately backup your Developer ID signing identities after creating them, as described in
“Exporting Your Developer Profile” (page 160).

If you want multiple Developer ID certificates, read “Requesting Additional Developer ID Certificates” (page
155).
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Note:  Only a team agent can request Developer ID certificates. If you’re an individual developer,
you’re the team agent and can request these certificates. Contact product-security@apple.com
if you want to revoke Developer ID certificates.

Verifying Your Steps
To verify your steps, view your Developer ID certificates in Accounts preferences, as described in “Viewing
Signing Identities and Provisioning Profiles” (page 147).

Code Signing Your Application
Optionally, code sign your application during development and testing using the Developer ID Application
certificate. Later, you re-sign the application with this certificate when you archive and export it from Xcode.

To code sign an application with your Developer ID Application certificate

1. In the Xcode project editor, select the target.
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Important:  If you want to sign multiple targets with the same code signing identity, select the
project, not a target.

2. Click Build Settings.

3. Click All.

4. Type Code Signing in the search field in the Build Settings pane of the project editor.

The list of build settings now shows only the Code Signing settings.

5. From the Code Signing Identity pop-up menu, choose your Developer ID Application certificate.

6. Click Run.

Exporting a Developer ID-Signed Application
To export your application for distribution outside of the Mac App Store, use the Archives organizer.

To create a Developer ID-signed application

1. In Xcode, choose Product > Archive.
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Xcode constructs an archive containing your code-signed application and opens the Organizer window,
showing the archive.

Note:  Xcode re-signs the archive with the Developer ID certificate in a later step.

2. Select the newly created archive in the Organizer window, and click Distribute.

Distributing Applications Outside the Mac App Store
Creating Developer ID-Signed Applications or Installer Packages

2014-02-11   |   Copyright © 2014 Apple Inc. All Rights Reserved.

222



3. In the dialog that appears offering a choice of distribution methods, select Export Developer ID-signed
Application, and click Next.

4. Choose your Developer ID certificate name from the Developer ID pop-up menu, and click Export.
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If you’re an individual developer, your name appears in the pop-up menu; otherwise, your company
name appears in the pop-up menu.

5. Enter a filename and location to save the signed application, and click Save.

Signing an Installer Package
If you want to distribute your application outside the Mac App Store as part of an installer package, create the
package as you normally do. One way to create the installer package is to use the packagemaker(1)
command-line utility. Code sign the package with your Developer ID Installer certificate with the productsign
command. To test your installer package, use the following command and replace MyPackageName.pkg with
the filename of your package:

spctl -a -v --type install MyPackageName.pkg
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Warning:  Make sure you sign the installer package using your Developer ID Installer certificate. The

productsign command-line utility allows you to sign an installer package using your Developer ID

Application certificate. Although this approach may appear to work, the resulting installer archive will

fail on the destination Mac.

If your development process includes code signing from the command line, read Code Signing Guide .

Verifying Your Steps
Before you distribute your application, test the end-user experience by launching your application with
Gatekeeper enabled and disabled. You can enable and disable Gatekeeper using System Preferences. Use the
spctl(8) command-line utility for verifying and testing Gatekeeper too. To simulate the end-user experience,
you need to quarantine your application and test it again with Gatekeeper enabled.

Enabling and Disabling Gatekeeper
You turn on and off Gatekeeper by using the Security & Privacy preferences in System Preferences. You can
turn off Gatekeeper and verify the status of Gatekeeper using the spctl(8) command-line utility.

To enable or disable Gatekeeper using the Security & Privacy preferences

1. In the Finder, launch System Preferences and select Security & Privacy.

2. Click the lock button if it appears locked, and enter the administrator password.
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3. To enable Gatekeeper, select “Mac App Store and identified developers.”

4. To disable Gatekeeper, select Mac App Store or Anywhere.

To disable Gatekeeper using the spctl command

1. In Terminal, enter the following command:

$ sudo spctl --master-disable

2. Press Return.

3. When prompted, enter your administrator password.

To confirm that Gatekeeper is enabled using the spctl command

1. In Terminal, enter the following command:

$ spctl --status
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2. Press Return.

If Gatekeeper is enabled, the output of this command is:

assessments enabled

If Gatekeeper is disabled, the output of this command is:

assessments disabled

Testing Gatekeeper Behavior
After signing your application with a Developer ID certificate, you can test whether it was signed correctly and
simulate the launch behavior of your application when Gatekeeper is enabled. On a Mac with Gatekeeper
enabled, a quarantined copy of your application launches only if it’s Developer ID signed. (Learn about quarantine
in this Knowledge Base article.) You can also test the behavior of Gatekeeper for an application that isn’t
Developer ID signed.

Testing a Developer ID-Signed Application
You can use the spctl command-line utility to test whether your application is signed correctly using a
Developer ID certificate.

To test your Developer ID-signed application

1. Enable Gatekeeper on your test Mac by selecting “Mac App Store and identified developers” from the
Security & Privacy preferences in System Preferences.

2. Enter the following command in Terminal by replacing TrackMix.appwith the path to your application.

$ spctl -a -v TrackMix.app

3. Press Return.

If the application is correctly signed, the output of this command is:

./TrackMix.app: accepted

source=Developer ID
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Testing the Launch Behavior
To thoroughly test your Developer ID-signed application, simulate launching the application on a Mac not
used for development.

To prepare for testing Gatekeeper behavior

1. Enable Gatekeeper on your test Mac, as described in “Enabling and Disabling Gatekeeper” (page 225).

2. Quarantine a copy of your Developer ID–signed application. You can do this in either of the following
ways:

 ● Email your Developer ID–signed application to yourself and use the copy that Mail downloads.

 ● Host your Developer ID–signed application on your own local or remote server and use the copy
that Safari downloads.

You’re ready to test Gatekeeper behavior.

To test Gatekeeper behavior for your Developer ID-signed application

 ● In the Finder, locate the quarantined copy of your Developer ID–signed application and double-click
its icon.

The Mac displays an alert asking whether you’re sure you want to open the application.

This alert, which allows you to open the quarantined application with Gatekeeper enabled, confirms
that your Developer ID application is built correctly.

Tip:  If an alert doesn’t appear at this point, it’s likely that you have opened a nonquarantined copy of
your application. Review the steps in “To prepare for testing Gatekeeper behavior” (page 228).
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To test Gatekeeper behavior for blocking applications that aren’t Developer ID signed

1. Enable Gatekeeper on your test Mac, as described in “Enabling and Disabling Gatekeeper” (page 225).

2. Quarantine a copy of your application that isn’t Developer ID signed.

As before, you can invoke quarantine on this copy of your application in either of the following ways:

 ● Email your application to yourself and use the copy that Mail.app downloads.

 ● Host your Developer ID-signed application on your own local or remote server and use the copy
that Safari downloads.

3. In the Finder, locate the quarantined copy of your non-Developer ID-signed application and double-click
its icon.

The Mac displays an alert that blocks you from opening the application. By way of this alert, Gatekeeper
protects a Mac by preventing first-time opening of applications from unidentified developers.
Applications previously opened by a user are no longer quarantined, and Gatekeeper doesn’t prevent
them from launching.

Recap
In this chapter, you learned how to distribute your Mac application outside of the Mac App Store so that users
won’t block your app from launching.
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Just as troubleshooting is a part of every complex technical process, it’s a necessary part of developing, testing,
submitting, and releasing an app. The potential problems you may encounter are organized here in four general
areas—certificates, provisioning, building, and debugging—with each problem followed by specific advice.
Use this chapter as a reference to find solutions to problems you might encounter.

Certificate Issues
Before you re-create a certificate that has become invalid or unusable, see whether it has one or more of the
following common problems.

You’re Missing Signing Identities or Code-Signing Certificate
Xcode detects when you’re missing a signing identity, as needed, depending on the operation you’re performing.
For example, if you attempt to run an app on a iOS device, a dialog may appear asking if Xcode should request
a missing development certificate. If this happens, click Fix Issue or Request in the dialog that appears.

If the certificate already exists in Member Center, a “Your account already has a valid certificate” dialog appears.
Typically, this happens when you move from one Mac to another. If possible, export your certificates as a
developer profile file on the other Mac, and then import them on your new Mac, as described in “Exporting
and Importing Certificates and Profiles” (page 159). If you don’t have a backup of your developer profile, click
the “Revoke and Request” button when the “Your account already has a valid certificate” dialog appears.

You can also request specific types of certificates, as described in “Requesting Signing Identities” (page 149).

No Matching Signing Identity or Provisioning Profiles Found
If a warning message and Fix Issue button appear below the Team pop-up menu in the General pane or in a
section of the Capabilities pane in the project editor, read the message and click the Fix Issue button. Xcode
may present a series of dialogs asking for more information. For example, a dialog might ask you to select a
team for your project, request your development certificate, or register a device. Xcode needs these assets to
create your team provisioning profile. If Xcode doesn’t resolve the issue, first follow all the steps in “Configuring
Identity and Team Settings” (page 25) to verify your project configuration.
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For iOS apps, connect a device you want to use for development to your Mac and choose it from the Scheme
toolbar menu before clicking Fix Issue. (Xcode automatically registers connected devices selected from this
menu.) If the device doesn’t appear in the menu, enable it for development, as described in “Registering Devices
Using Xcode” (page 188).

Read “The Private Key for Your Signing Identity Is Missing” (page 231) if you’re missing a private key in your
keychain.

The Private Key for Your Signing Identity Is Missing
Code signing fails if the private key for your signing identity isn’t in your keychain.

If the private key for your development certificate is missing, Xcode displays a warning message and several
options to fix the issue below the Team pop-up menu in the General pane in the project editor. If you created
a backup of your signing identities on this or another Mac, as described in “Exporting Your Developer
Profile” (page 160), click the Import Developer Profile button to restore the private key in your keychain.
Otherwise, click the “Revoke and Request” button to create a new signing identity. Remove the signing identity
with the missing private key from you keychain, as described in “Removing Signing Identities from Your
Keychain” (page 164).

If you use a custom development provisioning profile that you manage yourself, it becomes invalid after
revoking the development certificate. Read “Editing Provisioning Profiles in Member Center” (page 201) to
regenerate it.

If the private key for a distribution certificate is missing, try to restore it from a developer profile backup, as
described in “Importing Your Developer Profile” (page 163). If you can’t retrieve your private keys from another
Mac, refer to “Re-Creating Certificates and Updating Related Provisioning Profiles” (page 170) to re-create these
types of certificates. You can perform these steps for one or more certificates.

The Private Key for a Developer ID Certificate Is Missing
Follow the same steps in “The Private Key for Your Signing Identity Is Missing” (page 231) to repair Developer
ID certificates, except contact Apple at product-security@apple.com if you need to revoke Developer ID
certificates. Alternatively, you can continue to develop and distribute applications by requesting additional
Developer ID certificates, as described in “Requesting Additional Developer ID Certificates” (page 155).

Your Certificates Are Invalid Because You’re Missing an Intermediate Certificate
If your certificates are invalid, you could be missing the intermediate certificate used to authenticate your
certificate. If you verify your certificate in Keychain Access, as described in “Verifying Using Keychain
Access” (page 153), and instead of a green circle with a checkmark, a red circle with a white X appears with the
status “This certificate was signed by an unknown authority,” you’re missing the intermediate certificate. If you
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don’t have a certificate called Apple Worldwide Developer Relations Certification Authority in your system
keychain, read “Installing Missing Intermediate Certificate Authorities” (page 158) to learn how to reinstall it.
The intermediate certificate for Developer ID certificates is called the Developer ID Certification Authority .

Your Certificates Have Trust Issues
If you view your certificate in Keychain Access, and a blue circle and white plus sign appear in the detail area
instead of a green circle with a checkmark, your certificate has trust issues. To learn how to fix this problem,
read “Xcode Doesn’t Trust Your Certificate” (page 234).

Your Provisioning Profile or Signing Identity Doesn’t Appear in Xcode Menus
Occasionally, your provisioning profile or signing identity doesn’t appear in a Provisioning Profile or Signing
Identity pop-up menu when distributing your app using the Devices organizer or when setting the Code
Signing Identity build setting in the project editor. When this occurs, refresh provisioning profiles in Xcode, as
described in “Refreshing Provisioning Profiles in Xcode” (page 199).

If your provisioning profile still doesn’t appear in the Code Signing Identity build setting menu, choose Don’t
Code Sign or a certificate under Automatic Profile Selector from the Code Signing Identity menu. The next
time you choose the Code Signing Identity menu, your provisioning profile should appear in the menu.

Duplicate Signing Identities or Provisioning Profiles Appear in Accounts Preferences
The view details dialog in Accounts preferences displays signing identities that are in your keychain, not
certificates in Member Center. You can have multiple accounts and belong to different teams, but you should
have only one of each type of certificate for each team. For a list of the certificate types, refer to Table 11-2 (page
180). If duplicate signing identities appear, you can remove the expired or revoked signing identities from your
keychain, as described in “Removing Signing Identities from Your Keychain” (page 164).

If duplicate provisioning profiles appear in the view details dialog in Accounts preferences, refresh provisioning
profiles in Xcode, as described in “Refreshing Provisioning Profiles in Xcode” (page 199).

Your Certificates Have Expired
You can’t renew expired certificates. Read “Replacing Expired Certificates” (page 170) for how to remove the
expired certificates and request new ones.

Troubleshooting
Certificate Issues
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Mac Note:  If your Developer ID certificates expire, users can still download, install, and run versions
of your Mac applications that were signed with these certificates. However, you’ll need new Developer
ID certificates to sign updates and create new applications.

Your Request Has Timed Out
If a dialog appears stating that your request has timed out, the Certificates, Identifiers & Profiles section of
Member Center is probably down for maintenance. To see whether you have access to Certificates, Identifiers
& Profiles, sign in to Member Center using the same Apple ID credentials you entered in Xcode. In Certificates,
Identifiers & Profiles, select Certificates or Provisioning Profiles. If you can view your assets, Certificates, Identifiers
& Profiles is not down.

Provisioning Issues
Common provisioning issues result from using the wrong provisioning profile with your app or using an invalid
or expired provisioning profile.

Provisioning Profiles Installed on Your Device Are Invalid
If the provisioning profile on your development device has expired or is invalid, remove it as described in
“Removing Provisioning Profiles from Devices” (page 204).

Provisioning Profiles Appear Invalid in Member Center
If a team provisioning profile appears invalid in Member Center, refresh provisioning profiles in Xcode, as
described in “Refreshing Provisioning Profiles in Xcode” (page 199).

If a provisioning profile you manage appears invalid in Member Center, remove or edit it, as described in
“Removing Provisioning Profiles from Member Center” (page 206) and “Editing Provisioning Profiles in Member
Center” (page 201).

No Such Provisioning Profile Was Found
If a “Your build settings specify a provisioning profile with […] however, no such provisioning profile was
found.” warning message appears below the Team pop-up menu in the General pane, you may have incorrect
Provisioning Profile and Code Signing Identity build settings from using an earlier version of Xcode.

When this occurs, click the Fix Issue button below the warning message. If necessary, click the Fix Issue button
again. The Provisioning Profile build setting should be None and the Code Signing Identity build setting should
be Automatic > iOS Developer for iOS apps, and Automatic > Mac Developer for Mac apps.

Troubleshooting
Provisioning Issues
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If you’re using a custom development provisioning profile, read “Setting the Code Signing Identity Build
Setting” (page 176) for how to configure your project.

Build and Code Signing Issues
If you use the team provisioning profile that Xcode manages for you during development, as described in
“Team Provisioning Profiles in Depth” (page 88), Xcode fixes code signing and provisioning issues for you
before you attempt to build your app. In this case, you shouldn’t set the Code Signing Identity build settings
yourself. However, if you want to use a custom development provisioning profile and set these build settings,
as described in “Setting the Code Signing Identity Build Setting” (page 176), you may encounter build issues
described in this section. Common build errors tend to involve incorrect code signing identities.

Xcode Can’t Find Your Provisioning Profile
You’ll receive the following error message after replacing a provisioning profile with a modified version, such
as when a provisioning profile’s App ID changes:

Code Sign error: Provisioning Profile 'xxxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxx' can’t
be found

To address this error, ensure that the correct provisioning profile and code signing identity are selected for
the value of the Code Signing Identity build setting. This error may also occur if the project’s and target’s Code
Signing Identity build settings are different.

Xcode Doesn’t Trust Your Certificate
You get this error message when Xcode can’t verify the authenticity of your development or distribution
certificate:

Code Sign error: CSSMERR_TP_NOT_TRUSTED

If the trust setting isn’t Use System Defaults, you’ll receive a CSSMERR_TP_TRUSTED error message from the
codesign command-line utility when you build and run your app. Don’t change the trust settings of your
certificates from the default Use System Defaults. Follow these steps to repair your development, distribution,
and intermediate certificates.

Troubleshooting
Build and Code Signing Issues
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To set the trust level of a certificate to the system defaults

1. Launch Keychain Access.

2. In the Category section, select My Certificates.

3. Double-click the certificate.

4. In the certificate window, display the Trust section by clicking the corresponding disclosure triangle.

5. For the option “When using this certificate,” select Use System Defaults.

6. Close the certificate window.

7. Ensure that the certificate information shows the certificate is valid.

The Code Signing Identity Build Setting Doesn’t Match Any Certificates
You’ll receive the following error message when your certificate has expired or is otherwise invalid:

Code Signing Identity 'iPhone Developer' doesn't match any valid, non-expired,
certificate/private key pair in your keychain.

For multiple targets that use the same code signing identity, you should set this build setting at the project
level, not the target. However, if it’s set on both the project and the target, the target setting overrides the
project setting. If the target’s Code Signing Identity build setting is set, delete it by first selecting it and then
choosing Edit > Delete. Finally, set the project’s Code Signing Identity build setting to your certificate.

If your development certificate or team provisioning profile doesn’t appear in the Code Signing Identity menu,
try refreshing the provisioning profiles, as described in “Refreshing Provisioning Profiles in Xcode” (page 199),
and choose a valid code signing identity, as described in “Setting the Code Signing Identity Build Setting” (page
176).

Your Keychain Contains Duplicate Code Signing Identities
You get one of these error messages when there are duplicate code signing identities in your keychain, such
as two development identities or two distribution identities (your keychain must contain at most one code
signing identity of each type):

Build error "iPhone Developer: <your_name> (XYZ123ABC): ambiguous (matches "iPhone
Developer: <your_name> (XYZ123ABC)" in /Library/Keychains/System.keychain and
"iPhone Developer: <your_name> (XYZ123ABC)" in
/Users/../Library/Keychains/login.keychain)"

Troubleshooting
Build and Code Signing Issues
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[BEROR]CodeSign error: Certificate identity 'iPhone Distribution: <your_name>'
appears more than once in the keychain. The codesign tool requires there only be
one.

To address these errors, try deleting the duplicate code signing identities from your keychain, as described in
“Removing Signing Identities from Your Keychain” (page 164).

The App ID in Your Provisioning Profile Doesn’t Match Your App’s Bundle Identifier
When there’s a conflict between the App ID in the provisioning profile selected in the Code Signing Identity
build setting and your app’s bundle identifier, you get error messages similar to the following:

Code Sign error: Provisioning profile 'MyApp Profile' specifies the Application
Identifier 'com.mycompany.MyApp.*' which doesn't match the current setting
'com.mycompany.MyApp'

To address these errors, ensure that your bundle identifier is set correctly in your Xcode project, that the
certificate and provisioning profile specified in the Code Signing Identity build setting is correct, and that the
provisioning profile uses the correct App ID.

Your iOS Device Isn’t Listed as a Run Destination
If you have a project or workspace open and your connected device isn’t listed as a run destination in the
Scheme pop-up menu, verify that:

1. Your device is enabled for development.

Read “Registering Devices Using Xcode” (page 188) for how to enable a device for development.

2. Your device contains a valid provisioning profile.

3. The app’s targeted iOS version is equal to or greater than the iOS version installed on your device.

See “Setting the Target iOS Devices” (page 37) for details.

4. The version number of the iOS SDK your project uses is equal to or greater than the version number of
the iOS version on your device.

For example, if Xcode shows iOS SDK 4.3 but your device has iOS 5.0 installed, you need to install on your
Mac an Xcode version that includes iOS SDK 5.0.

Troubleshooting
Build and Code Signing Issues
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Debugging Information Issue
The most common potential problem with debugging is that Xcode hasn’t yet collected the information from
your device.

Xcode Displays the Unknown iOS Detected Dialog When You Connect a Device
This message appears when Xcode hasn’t seen a particular version of iOS before and needs to download (from
the device) the debugging symbols for that version from the device. To successfully debug apps on the device,
leave the device connected until Xcode finishes downloading the debugging symbols from the device.

Troubleshooting
Debugging Information Issue
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Added steps to manage asset catalogs, revoke certificates in Xcode, install
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New document that describes the common workflows to develop, test,
and distribute your app.
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ad hoc provisioning profile  A type of distribution
provisioning profile used for distributing an iOS app
for testing.

App ID  A string that identifies one or more apps
from a single team. An App ID consists of a bundle
ID search string preceded by the Team ID, a
10-character string generated by Apple to uniquely
identify a team.

Apple Developer Program  Subscription services
that offer Apple developers access to technical
resources and support to develop apps for the App
Store and Mac App Store. Developers can join one
or more of the separate programs for iOS, Mac, and
Safari development.

Apple ID  An Apple-issued developer account with
a name and password. Developers use their Apple
ID credentials to sign in to any of the developer
program tools. A developer or Apple ID can belong
to multiple teams, and teams can belong to multiple
types of developer programs.

Apple Push Notification service (APNs)  The service
(servers and other infrastructure) that Apple provides
to allow developers to push notifications to apps. A
message sent by the service is called a push
notification.

Apple Worldwide Developer Relations Certification
Authority  The certificate authority that validates
development and distribution certificates for apps
submitted to the App Store and the Mac App Store.

App Store  A service for purchasing and
downloading iOS apps. The App Store is available
on iOS devices and in the iTunes Store on Mac and
Windows computers.

bundle ID  A reverse DNS string that precisely
identifies a single app.

bundle ID search string  The second part of an App
ID that’s supplied by developers to match a set of
bundle IDs, where each bundle ID identifies a single
app. For example, if the bundle ID search string is
com.mycompany.MyApp or a wildcard such as
com.mycompany.*, it matches the bundle ID
com.mycompany.MyApp.

certificate authority  An organization that
authorizes a certificate.

Certificates, Identifiers & Profiles  An area of
Member Center available to iOS, Mac, and Safari
Developer Program members that provides resources
needed to develop iOS and Mac apps and Safari
Extensions.

certificate signing request (CSR)  A file that contains
personal information used to generate a signing
certificate. This file also contains the public key to
be included in the certificate, along with identifying
information.

client SSL certificate  A certificate that allows a
developer’s server to connect to an Apple service.
For example, developers use a client SSL certificate
to communicate with the Apple Push Notification
service.
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code signing certificate  A signing certificate used
to sign an app or installer.

company  A type of Apple Developer Program
account that has one or more team members.

crash report  A report generated by the operating
system when an app crashes.

data protection  A digital safeguard that adds a
level of security to files stored on disk by an app.

Developer ID  The name of the feature that
developers use to distribute code-signed
applications outside the Mac App Store.

developer profile  A file that contains a developer’s
development certificates, distribution certificates,
and provisioning profiles.

development certificate  A type of signing
certificate used during development that identifies
a single developer on a team. It allows an app to
launch on a device through Xcode.

development provisioning profile  A type of
provisioning profile that authorizes an app to use
certain technologies and run on designated devices
during development. This profile consists of a name,
multiple development certificates, multiple devices,
and an App ID.

device  Used to refer to a Mac computer—or to an
iPad, iPhone, or iPod—when no further distinction
between them is needed.

device ID  A way of uniquely identifying an iOS or
Mac device.

distribution certificate  A type of signing certificate
used to distribute an app and allow it to launch on
a device without the assistance of Xcode. A
distribution certificate identifies a team, not a team
member.

distribution provisioning profile  A type of
provisioning profile that authorizes an app to run
on devices without the assistance of Xcode and
allows them to use certain technologies. A
distribution provisioning profile is used to submit
an app to the App Store or Mac App Store. Mac has
one type of distribution provisioning profile, and iOS
has two.

entitlement  A single right granted to a particular
app, tool, or other executable that gives it additional
permissions beyond what it would ordinarily have.

explicit App ID  An App ID that matches a single
bundle ID, in contrast to a wildcard App ID, which
can match one or more bundle IDs.

Game Center  Apple’s social gaming network that
allows players to connect to the service and
exchange information with other players.

Gatekeeper  The OS X feature that enables users to
choose to disallow the launching of applications that
aren’t code signed by developers known to Apple.

iCloud  A type of storage that allows developers to
share a user’s data among multiple instances of an
app running on other iOS and OS X devices.

In-App Purchase  A mechanism for embedding
items to purchase directly into an app. In this way,
a developer can connect to the App Store or Mac
App Store and securely process payments from the
user.

individual  Used to describe a type of Apple
Developer Program account that has one developer.

intermediate certificate  A certificate that’s required
to be in a developer’s keychain to ensure that a
signing certificate is issued by a trusted source.

Glossary
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iOS App Store Package  A type of OS X file that,
when double-clicked installs an app in iTunes, where
it can be synced to an iOS device.

iOS Dev Center  An Apple developer center that
provides all the resources needed to develop iOS
apps.

iOS Developer Program  A program that allows
developers to develop iOS apps, test them on
iOS-based devices, and distribute them to users.

Mac Developer Program  A program that allows
developers to develop Mac apps, and distribute them
to users.

Mac Installer Package  A type of OS X file that, when
double-clicked, launches the Installer and installs a
Mac app on a computer.

Newsstand  An iOS app for purchasing and
organizing newspaper and magazine subscriptions
into a folder.

Passbook  An iOS app for organizing and using
passes, tickets, and coupons.

passes  Digital representations of information that
allow users to redeem a real-world product or
service, such as a coupon, a ticket for a show, or a
boarding pass.

provisioning  The process of preparing and
configuring an app to launch on devices and use
certain services.

provisioning profile  A type of system profile used
to provision one or more apps.

push notification  A message sent from an app, that
isn’t running in the foreground, to the user using
Apple Push Notification service (APNs).

quarantine  The state of a file or an application that,
when a user first attempts to open the item, triggers
the Gatekeeper feature. OS X imposes a quarantine
on items downloaded from the web, from email, and
so on.

routing app  An app that offers routing information,
such as turn-by-turn navigation services. An app can
register as a routing app and make those directions
available to Maps and other apps.

signing certificate  A certificate used for signing
other entries, such as installer packages, email
messages, and the like.

signing identity  A digital identity used for code
signing, including archive signing. A signing identity
includes the certificate with its private and public
keys stored in the keychain.

store  Used as a short form of the App Store or the
Mac App Store when there’s no distinction between
the two.

symbolicate  To replace memory addresses in a
crash report with human-readable function names
and line numbers.

team admin  A person on a development team who
has some of the privileges of a team agent but can’t
sign agreements. Team admins help team agents
delegate some of their responsibilities. Compare
team agent; team member.

team agent  The person on a development team
who has unrestricted access to the team and who is
legally responsible for it. Compare team admin; team
member.

Team ID  A 10-character string that’s generated by
Apple to uniquely identify your team. The Team ID
is used as the prefix for an App ID.
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team member  A person on a development team
who has the fewest privileges. A team member can
can sign apps during development after that request
is approved by a team admin. Compare team agent;
team admin.

team provisioning profile  The development
provisioning profile that Xcode creates and manages
for you. The team provisioning profile contains all
of a team’s development certificates, its registered
devices, and the wildcard App ID, which Xcode also
creates.

wildcard App ID  An App ID that matches one or
more bundle IDs used by a development team.
Compare explicit App ID.

Xcode iOS Wildcard App ID  The wildcard App ID
that Xcode manages for iOS developers.

Xcode Mac Wildcard App ID  The wildcard App ID
that Xcode manages for Mac developers.

Glossary
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